Cisco Desktop Administrator User Guide

CAD 8.5 for Cisco Unified Contact Center Express Release 8.5
Cisco Unified Communications Manager Edition

First Published: December 2010
Last Modified: December 18, 2012

Americas Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
800 553-NETS (6387)
Fax: 408 527-0883
Contents

Preface 11

■ Introduction 11
  What’s New In This Release 12
  Cisco Desktop Administrator Feature Levels 12
  Related Documentation 14
  Obtaining Documentation and Submitting a Service Request 14
  Documentation Feedback 14

1 Getting Started with Cisco Desktop Work Flow Administrator 15

■ Introduction 15
■ Starting Desktop Work Flow Administrator 16
■ Modifying the Unified CCX Server IP Address 17
■ Automated Updates 19
  Application Downgrades 20
■ The Desktop Work Flow Administrator Interface 21
  Toolbar 21
  Navigation Tree Pane 22
  Display Pane Navigation 22
■ User Privileges in Windows XP and Vista 23
■ Passwords 24
  Configuring a Password in Desktop Work Flow Administrator 24
    Setting Up a Password 24
    Changing a Password 25
    Deleting a Password 25
  Client Applications 25
■ Synchronizing Directory Services 26
Contents

2  Work Flow Configuration  27

■  Dial Strings  29
  North American Dial String Format 29
  Telephone Number Display Tab  30
  Outgoing Calls Tab  31
  Advanced Internal Dialing Tab  33
  Advanced External Dialing Tab  34
  Miscellaneous Tab  35
  Variable Length Dial String Format  36
  Telephone Number Display Tab  37
  Phone Number Format Tab  38
  Miscellaneous Tab  40

■  Phone Book  41
  Using the Phone Book Filter  42
  Creating Phone Books  43
  Enabling or Disabling Phone Books  44
  Importing and Exporting Phone Books  45
  CSV File Format  45

■  Reason Codes  48
  Assigning Reason Codes  51
  Enabling or Disabling Reason Codes  52

■  Wrap-up Data  53
  Creating Wrap-up Data Descriptions  54
  Assigning Wrap-up Data Descriptions  56
  Enabling or Disabling Wrap-up Data  56
  Automatic State Changes  57

■  Work Flow Groups  58
  Maintaining Work Flow Groups  59

■  Enterprise Data  61
  Data  61
  Call Activity  62

■  CAD, CAD-BE, and IP Phone Agent  64
  CAD Agent  64
Contents

CAD-BE Agent 64
IP Phone Agent 64

■ User Interface 65
  Toolbar 65
  Adding and Removing Toolbar Buttons 65
  Adding the Cisco Unified Outbound Dialer Toolbar 66
  Associating Actions with Task Buttons 66
  Changing a Task Button’s Hint 67
  Customizing Button Icons 67

Show Data Fields 69
  Configuring and Renaming Data Fields 69
  Show Duration 70

Miscellaneous 71
Browser Setup 72
  Enabling the Integrated Browser 73
  Enabling Access to Other Websites 73
  Enabling Hyperlink Dialing 74
  Configuring the Number of Browser Tabs 74
  Enabling Popups to be Displayed in a New Window 75
  Setting Up the Home Page 75
  Setting Up Work Sites 75

Remote Access 76
  IPC Make Call Action 78
  IPC High Priority Chat Action 78
  IPC Record Action 79
  IPC Agent Notification Action 79
  IPC Set Variable Action 80

■ Voice Contact Work Flows 81
  Creating a Voice Contact Work Flow 82
    Setting Up a New Voice Contact Classification 83
    Setting Up a New Work Flow 84
    Data Field Conditions 85
    Wild Card Searches 87
  Modifying a Voice Contact Work Flow 87
Contents

Voice Contact Work Flows and Outbound Dialer 88
Deleting a Voice Contact Work Flow 88
  ■ E-Mail Contact Work Flows 90
  ■ Agent Management Work Flows 91
    Creating an Agent Management Work Flow 92
  ■ Actions 96
    Action Availability 97
    Adding a New Action 98
    Editing an Action 99
    Deleting an Action 99
    Importing and Exporting Actions 99
    Agent Notification Action 103
    Agent State Action 105
      Automated Reason Codes for Agent State Changes 105
    Call Control Action 107
    Delay Action 108
    HTTP Action 109
      Reserved Characters 113
      Example of an HTTP Request 114
    IPC Action 117
    Launch External Application Action 119
    Run Macro Action 121
      Macro Recording Tips 122
      Allowed Macro Keystrokes 124
      Recording Macros 125
      Data Fields 129
    Set Enterprise Data Action 132
    Timer Action 134
    Utility Action 135
      High Priority Chat Messages 135
  ■ Agent’s State Change Notification and Announcement 137
  ■ Cisco Unified CCX Outbound Preview Dialer 141
    Outbound Dialer Actions 141
    Outbound Dialer Toolbar 142
### Contents

Outbound Dialer Enterprise Data 144

---

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Getting Started with Desktop Administrator</td>
</tr>
<tr>
<td>■ Introduction</td>
<td>145</td>
</tr>
<tr>
<td>■ Accessing Desktop Administrator</td>
<td>146</td>
</tr>
<tr>
<td>■ Using the Search Function</td>
<td>148</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Services Configuration</td>
</tr>
<tr>
<td>■ Introduction</td>
<td>149</td>
</tr>
<tr>
<td>■ Configuring Enterprise Data</td>
<td>150</td>
</tr>
<tr>
<td>■ Fields</td>
<td>151</td>
</tr>
<tr>
<td></td>
<td>Creating a Custom Field</td>
</tr>
<tr>
<td></td>
<td>Editing a Field</td>
</tr>
<tr>
<td></td>
<td>Deleting a Field</td>
</tr>
<tr>
<td>■ Layouts</td>
<td>155</td>
</tr>
<tr>
<td></td>
<td>Creating a Custom Layout</td>
</tr>
<tr>
<td></td>
<td>Copying a Layout</td>
</tr>
<tr>
<td></td>
<td>Editing a Layout</td>
</tr>
<tr>
<td></td>
<td>Deleting a Layout</td>
</tr>
<tr>
<td>■ Configuring Display Settings</td>
<td>158</td>
</tr>
<tr>
<td>■ Configuring Desktop and Server Monitoring and Recording</td>
<td>161</td>
</tr>
<tr>
<td></td>
<td>Enabling Desktop Monitoring</td>
</tr>
<tr>
<td></td>
<td>Configuring a Default Monitor Service</td>
</tr>
<tr>
<td></td>
<td>Assigning Phone Devices to a Specific VoIP Monitor Service</td>
</tr>
<tr>
<td></td>
<td>Removing a VoIP Monitor or Recording &amp; Playback Service from Directory Services</td>
</tr>
<tr>
<td>■ Synchronizing Directory Services</td>
<td>166</td>
</tr>
<tr>
<td>■ Releasing the Desktop Administrator Lock</td>
<td>167</td>
</tr>
</tbody>
</table>
Contents

5 Personnel Configuration 169
  ■ Introduction 169
  ■ Configuring Agents 170
    Changing an Agent’s Work Flow Group 170

6 Cisco Unified Presence Settings 173
  ■ Introduction 173
  ■ Configuring the Cisco Unified Presence Server 174
    Configuring an Inbound Access Control List 174
    Configuring the CAD Client Type 174
  ■ Configuring the Cisco Unified Presence Cluster 176
  ■ Configuring Contact Lists 178
    Creating a Contact List 178
    Finding a Contact List 179
    Deleting a Contact List 180
    Editing a Contact List 180
    Adding SMEs to a Contact List 182
    Finding SMEs 183
  ■ Configuring External Contacts 187
    Adding External Contacts 187
    Finding an External Contact 189
    Editing an External Contact 190
    Deleting an External Contact 190
  ■ Configuring Work Flow Groups 192
    Finding a Work Flow Group 192
    Adding a Contact List to a Work Flow Group 193
    Selecting Agents to Appear Offline 195
  ■ Configuring Supervisor Chat and Team Messages 196
Preface

Introduction

Cisco Desktop Administrator consists of two parts:

- Desktop-based Cisco Desktop Work Flow Administrator
- Web-based Cisco Desktop Administrator

Cisco Desktop Work Flow Administrator enables you to configure the following:

- Dial strings
- Phone book
- Reason codes
- Wrap-up data
- Work flow groups

Cisco Desktop Administrator enables you to configure the following:

- Services Configuration
- Personnel
- Cisco Unified Presence Settings
- Agent E-Mail Settings
- CAD Configuration Setup

**NOTE:** Desktop Work Flow Administrator is not supported if installed on a virtual private network (VPN) desktop.
What’s New In This Release

- Cisco Work flow Administrator
  - Enable integrated browser popups as Internet Explorer popup windows
  - Set up single-step transfer and single-step conference call control actions
  - Enable agent e-mail review before sending it to the customer

- Cisco Desktop Administrator
  - Enable display and control of non-ACD calls for phones with multiple phone lines
  - Configure the following agent e-mail features:
    - Resuming e-mail processing on voice disconnect
    - Review process for agent e-mail
    - Forwarding an e-mail to an external account
    - Sending customer e-mail responses with carbon copy (CC) and blind carbon copy (BCC)
    - Printing e-mails
    - Distinct e-mail address for automatic e-mail responses
  - Use predefined variables in templates
  - Ability to enable/disable automatic updates
  - Automated client downgrades

Cisco Desktop Administrator Feature Levels

There are three versions of Cisco Desktop Administrator: Standard, Enhanced, and Premium. The following chart outlines the features available in each version. All features not listed here are present in all three versions.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Standard</th>
<th>Enhanced</th>
<th>Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Desktop Administrator</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configure enterprise data</td>
<td>×</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Configure desktop and server monitoring</td>
<td></td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Configure agent e-mail</td>
<td></td>
<td></td>
<td>×</td>
</tr>
<tr>
<td>Configure Cisco Unified Presence</td>
<td></td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Configure bulk import or export of phone books</td>
<td></td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Cisco Work flow Administrator</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Standard</td>
<td>Enhanced</td>
<td>Premium</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------</td>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td>Configure work flows</td>
<td></td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Configure work flow reason codes</td>
<td>×</td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Create work flow groups</td>
<td>×</td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Configure time of day work flow</td>
<td></td>
<td></td>
<td>×</td>
</tr>
<tr>
<td>Configure integrated browser</td>
<td></td>
<td>×*</td>
<td></td>
</tr>
<tr>
<td>Cisco Unified CCX Outbound Dialer</td>
<td></td>
<td></td>
<td>×</td>
</tr>
</tbody>
</table>

* CAD-BE only
Related Documentation

The following documents contain additional information about CAD 8.0:

- Cisco CAD Installation Guide
- Cisco Agent Desktop User Guide
- Cisco Agent Desktop—Browser Edition User Guide
- Cisco Supervisor Desktop User Guide
- Cisco IP Phone Agent User Guide
- Cisco CAD Troubleshooting Guide
- Cisco CAD Error Code Dictionary
- Integrating CAD with a Thin Client Environment
- Configuring and Troubleshooting VoIP Monitoring

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.

Documentation Feedback

You can provide comments about this document by sending email to the following address:

ccbu_docfeedback@cisco.com

We appreciate your comments.
Introduction

Cisco Desktop Work Flow Administrator comes with one license, so only one person can view and/or edit data in it at any one time. More than one instance of Desktop Work Flow Administrator can be open concurrently.

If someone is using Desktop Work Flow Administrator when you try to access it, an error message appears that identifies the IP address of the other user’s computer.

For this reason, it is important that you close Desktop Work Flow Administrator completely when you are done using it. As long as the application is running, a license is being used and others are blocked from accessing it. Unlike Desktop Work Flow Administrator, an administrator’s login in Desktop Administrator times out after 15 minutes of inactivity.
Starting Desktop Work Flow Administrator

To start Desktop Work Flow Administrator:


2. Click the Call Center 1 node to expand the navigation tree. By default, Desktop Work Flow Administrator is not password-protected and the tree will expand. If a password has been configured, you are asked to enter it now.

   For more information about passwords, see "Passwords" on page 24.
Modifying the Unified CCX Server IP Address

When Desktop Administrator is installed, it is configured to point to the Unified CCX server IP address. If that Unified CCX server IP address changes, you need to reconfigure Desktop Administrator so that it points to the new Unified CCX server IP address by launching CAD Configuration Setup from Desktop Work Flow Administrator or running PostInstall.exe.

To modify the Unified CCX server IP address:

1. Start CAD Configuration Setup.
   - In Desktop Work Flow Administrator, select the Call Center 1 node in the left pane and then choose Setup > Configure Systems from the menu bar.
   - On a PC having CAD desktop applications installed, navigate to the C:\Program Files\Cisco\Desktop\bin folder and double-click PostInstall.exe.

   Configuration Setup starts and displays the Location of Unified CCX server(s) dialog box (Figure 1).

2. Ensure that the correct primary (and optional secondary) Unified CCX server IP address is configured. If the Unified CCX server IP address is incorrect, enter the correct IP address, and then click OK.

   If you are running CAD Configuration Setup on a PC that hosts Desktop Administrator and no other CAD desktop application, you will receive a message that this computer is configured to point to the Unified CCX server and no other CAD settings can be configured through CAD Configuration Setup on this computer.

3. Click OK. Your computer now points to the Unified CCX server.

   If you are making changes in CAD Configuration Setup from Desktop Work Flow Administrator, choose File > Exit from the menu or click Close for changes to take effect.
NOTE: If you have installed other CAD desktop applications (Cisco Agent Desktop and Cisco Supervisor Desktop) on your PC, then the CAD Configuration Setup window appears (Figure 2). Choose File > Exit from the menu or click Close for changes to take effect.

Figure 2. CAD Configuration Setup
Automated Updates

Every time a client desktop application is launched, the software checks to see if there is an updated version available, or if there was a system configuration change that requires a Windows registry change. If either of these conditions exist, and the automatic updates are enabled in CAD Configuration Setup, the application automatically runs the update process. Automatic software update requires either administrative or elevated (system) privileges.

You can disable automatic updates in CAD desktop applications by clearing the Automatic Updates check box on the CAD Configuration Setup page, in the Desktop Administrator page. By default, automatic updates are enabled for CAD desktop applications.

**IMPORTANT:** If you disable automatic updates for CAD desktop applications, all the updates must be distributed and installed on all CAD client applications manually when available. For more information on distributing and installing the software updates, see the *Cisco CAD Installation Guide*. If the CAD client applications are not of the same version as the CAD server, then the client applications might not be able to log in or function properly.

**NOTE:** For automated updates to function correctly, Internet Explorer must be configured so that it checks for newer versions of stored pages. In Internet Explorer, choose Tools > Internet Options and select the General tab. In the Browsing history section, click Settings and ensure that any option other than Never is selected.

**NOTE:** If your system is configured with two Unified CCX servers, and one server is upgraded while your instance of Desktop Work Flow Administrator is connected to the older Unified CCX, and your system administrator performs a failover to switch all agents to the upgraded server, your instance of Desktop Work Flow Administrator will not automatically upgrade when you log into the new server. You must shut down Desktop Work Flow Administrator and start it again for the automatic upgrade to take place.

When an update is available, you will see a dialog box notifying you that your copy of Desktop Work Flow Administrator will be updated. Click OK to proceed with the update.

A progress bar is displayed to show you the status of the download.

When the update is finished, you will see a final dialog box that tells you the update is complete, and which applications were updated. If you have other CAD desktop applications that were updated, they will also need to be restarted to function properly.
applications (Cisco Agent Desktop and Cisco Supervisor Desktop) on your PC, they will all have been updated.

**NOTE:** Because Agent Desktop is automatically installed when Supervisor Desktop is installed, only Supervisor Desktop will be listed as having been updated in the final dialog box. Agent Desktop will be listed only if Supervisor Desktop is not present on your PC.

**NOTE:** On a machine where both Supervisor Desktop and Desktop Administrator are installed, if an automated update of one desktop application completes successfully but an automated update of the other desktop application fails to complete for any reason, then automated updates will no longer work. Refer to the *Cisco CAD Troubleshooting Guide* for more information.

When you click OK to close the dialog box, any CAD desktop application that had been running on your desktop restarts automatically.

**Application Downgrades**

CAD desktop applications can be downgraded to the earlier version when required. If a service downgrade occurs and automatic updates are enabled in CAD Configuration Setup, the CAD desktop applications are automatically downgraded to the older version. The existing CAD applications do not have to be manually uninstalled to install the older version.
The Desktop Work Flow Administrator Interface

The Desktop Work Flow Administrator interface has two panes (Figure 3). The left pane is a navigation tree similar to that found in Windows Explorer. The right pane displays the application that you choose in the left pane.

Figure 3. Desktop Work Flow Administrator interface

Toolbar

When you select a node on the navigation tree, the Desktop Work Flow Administrator menu bar and toolbar change to reflect the design of that node’s application.

The toolbar buttons you see are among those listed in Table 1.

Table 1. Desktop Work Flow Administrator toolbar buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="About icon" /></td>
<td>About</td>
<td>Displays copyright and version information</td>
</tr>
<tr>
<td><img src="image2.png" alt="Delete icon" /></td>
<td>Delete</td>
<td>Removes the selected work flow group</td>
</tr>
<tr>
<td><img src="image3.png" alt="Help icon" /></td>
<td>Help</td>
<td>Accesses Help files</td>
</tr>
</tbody>
</table>
Navigation Tree Pane

Use these mouse or keyboard actions in the left pane to navigate the tree.

Mouse
- Double-click an icon/application name to expand or collapse the tree.
- Click the plus sign ( + ) to expand the tree.
- Click the minus sign ( - ) to collapse the tree.
- Right-click to rename or delete a node (not available for all nodes).

Keyboard
With a node selected,
- Press the up and down arrow keys to move from one node to the next.
- Press the left arrow key to collapse the tree.
- Press the right arrow key to expand the tree.

Display Pane Navigation

The applications displayed in the right pane are designed to use shortcut keys and the tab key as alternatives to using the mouse to navigate around a window. The shortcut keys that apply to a specific node are discussed in the section devoted to that node’s functions.

Table 1. Desktop Work Flow Administrator toolbar buttons — Continued

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![New icon]</td>
<td>New</td>
<td>Adds a new work flow group</td>
</tr>
<tr>
<td>![Web icon]</td>
<td>Web</td>
<td>Opens your web browser and accesses Cisco’s website</td>
</tr>
</tbody>
</table>
User Privileges in Windows XP and Vista

Because Desktop Work Flow Administrator users must be able to update registry settings, they must have Administrator or Power User privileges on Windows XP and Vista platforms.

Only a person with Administrator privileges can change user privileges on the Administrator PC if it is necessary to upgrade them.
Passwords

A password is not required to access Desktop Work Flow Administrator. By default it is not password-protected. However, you can configure a password to protect access to Desktop Work Flow Administrator.

If you do not want Desktop Work Flow Administrator to be password-protected, you must not configure the password.

Configuring a Password in Desktop Work Flow Administrator

If a password is configured, when you select the logical contact center node you will be prompted to provide the password before you can access any of the subnodes.

If you forget the password, you can clear it so that no password is required for accessing Desktop Work Flow Administrator. See "Configuring CAD Configuration Setup Settings" on page 216 for more information.

Setting Up a Password

To set up a password:

1. In the navigation pane, select the Call Center 1 node.
2. From the menu bar, choose Setup > Change Password.
   The Administrator Password dialog box appears (Figure 4).

Figure 4. Administrator Password dialog box

3. Leave the Old Password field blank, and enter a new password, type it again to confirm it, and then click OK.
   Passwords are case sensitive and can consist of up to a maximum of 32 alphanumeric characters.
Desktop Work Flow Administrator is now password protected. You must restart the application for the change to go into effect.

**Changing a Password**

*To change your password:*

1. In the left pane, select the Call Center 1 node
2. From the menu bar, choose Setup > Change Password. The Change Password dialog box appears.
3. Enter your old password, a new password, and your new password again to confirm it, and then click OK.

   The password is now changed. You must restart Desktop Work Flow Administrator for the change to go into effect.

**Deleting a Password**

*To remove password protection:*

When you remove the password from Desktop Work Flow Administrator, you automatically reset the password in Desktop Administrator to the default value, which is blank.

1. In the left pane, select the Call Center 1 node
2. From the menu bar, choose Setup > Change Password. The Change Password dialog box appears.
3. Enter your old password, leave the New password and Confirm password fields blank, and then click OK.
4. You are asked to confirm that you want to leave Desktop Work Flow Administrator unprotected. Click Yes. The password is removed. You must restart the application for the change to go into effect.

**Client Applications**

User IDs and passwords are administered in Unified CM for the following applications:

- Cisco Agent Desktop
- Cisco Agent Desktop—Browser Edition
- Cisco Supervisor Desktop
- Cisco IP Phone Agent

The user’s password is verified on the CTI server when a user starts the application.
Synchronizing Directory Services

The Directory Services database should be synchronized with the master Unified CCX agent database. The databases are synced automatically whenever the master Unified CCX database changes. However, you can manually sync them with the Synchronize Directory Services command.

**NOTE:** You can synchronize Directory Services manually from the Desktop Administrator web application also. See "Synchronizing Directory Services" on page 166 for more information.

**To synchronize the databases manually:**

1. In the left pane, select the Call Center 1 node.
2. From the menu, choose Setup > Synchronize Directory Services.

   When the synchronization is complete, the system displays a confirmation message that Directory Services was successfully synchronized.
Work Flow Configuration

Introduction

Work Flow Configuration enables you to configure and maintain the appearance and behavior of Agent Desktop, Agent Desktop—Browser Edition, and IP Phone Agent. Work Flow Configuration has the following functions:

- Dial Strings (page 29)
- Phone Book (page 41)
- Reason Codes (page 48)
- Wrap-up Data (page 53)
- Work Flow Groups (page 58)

To use any Work Flow Configuration application, select its node in the left navigation pane of the Desktop Work Flow Administration window (Figure 5). The right display pane shows the selected node.
The CAD client applications must be restarted for any configuration changes you make to go into effect (Figure 5).

Figure 5. Work Flow Configuration window, Reason Codes node selected

NOTE: When configuring the name or ID of objects (examples are work groups, work flows, agent login names, server names, and macro names), do not use the “=” character. This can cause problems when backing up and restoring data.
Dial Strings

Use the Dial Strings option to configure the way desktop applications display and dial phone numbers.

NOTE: Dial strings for CAD-BE are not configurable.

Select the appropriate check box at the bottom of the Dial Strings pane to choose the dial string format you will use. The available formats are:

- North American Dial String format
- Variable Format Dial String format

Different tabs display depending on your choice.

North American Dial String Format

If you choose the North American dial string format, the following three tabs are active:

- Telephone Number Display Tab (page 30)
- Outgoing Calls Tab (page 31)
- Miscellaneous Tab (page 35)
Telephone Number Display Tab

The Telephone Number Display tab (Figure 6) enables you to configure how phone numbers are displayed in Agent Desktop.

Figure 6. Telephone Number Display tab

Table 2. Telephone Number Display tab fields

<table>
<thead>
<tr>
<th>Tab Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External number format</td>
<td>Specify the calling number and called number phone numbers format</td>
</tr>
<tr>
<td>Area code</td>
<td></td>
</tr>
<tr>
<td>Exchange</td>
<td></td>
</tr>
<tr>
<td>Subscriber code</td>
<td></td>
</tr>
<tr>
<td>Parentheses around area code</td>
<td></td>
</tr>
<tr>
<td>Area code/Exchange</td>
<td>Specify the separator between the area code and exchange</td>
</tr>
<tr>
<td>Dash</td>
<td></td>
</tr>
<tr>
<td>Space</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Exchange/Subscriber code</td>
<td>Specify the separator between the exchange and the subscriber code</td>
</tr>
<tr>
<td>Dash</td>
<td></td>
</tr>
<tr>
<td>Space</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

The selections you make are reflected in the Sample fields. (An exception is if you enter a value in either of the “Remove first ‘n’ digits” and “Remove last ‘n’ digits” fields. In that case, the sample does not change.)
Table 2. Telephone Number Display tab fields — Continued

<table>
<thead>
<tr>
<th>Tab Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal number format</td>
<td>Specify the internal phone numbers format. You can include an X (extension) and remove the leading or trailing digits (in the event that extension numbers are less than 4 digits long).</td>
</tr>
</tbody>
</table>

To configure the telephone number display:

- Select or clear the check boxes and radio buttons on the Telephone Number Display tab as desired, and then click Apply to save your changes.

Outgoing Calls Tab

The Outgoing Calls tab (Figure 7) enables you to configure your local area codes and exchanges.

Figure 7. Outgoing Calls tab
To configure outgoing calls:

- Enter information and select or clear the appropriate check boxes on the Outgoing Calls tab as desired, and then click Apply to save your changes.
Advanced Internal Dialing Tab

The Advanced Internal Dialing tab (Figure 8) enables you to configure more internal dialing options. Access it by clicking the Advanced Dialing button on the Outgoing Calls tab.

Figure 8. Advanced Internal Dialing tab

Table 4. Advanced Internal Dialing tab fields

<table>
<thead>
<tr>
<th>Tab Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extensions</td>
<td>The maximum number of digits in an internal extension number, from 1–9. If you select 7, you must specify the internal exchange and the corresponding range of subscriber numbers so the application can distinguish between a 7-digit internal phone number and a 7-digit outgoing call.</td>
</tr>
<tr>
<td>7-digit extensions</td>
<td>If you specified a 7-digit extension number, enter the internal exchange and the corresponding range of extension numbers from low to high. Click Add to add them to the list.</td>
</tr>
</tbody>
</table>
Advanced External Dialing Tab

The Advanced External Dialing tab (Figure 9) enables you to configure more external dialing options. Access it by clicking the Advanced Dialing button on the Outgoing Calls tab.

Figure 9. Advanced External Dialing tab

Table 5. Advanced External Dialing tab fields

<table>
<thead>
<tr>
<th>Window Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Neighboring area codes with local dialing privileges</td>
<td>The area codes to which you can place non-toll calls. Click Add to add a new area code to the list and click Delete to remove an area code from the list.</td>
</tr>
<tr>
<td>Exchanges for 7-digit local numbers</td>
<td>Choose the neighboring area code, then enter the exchanges within that area code which do not require you to dial 1 or the area code. Select All exchanges as 7-digit numbers if no exchange requires you to dial 1 or an area code.</td>
</tr>
</tbody>
</table>
The Miscellaneous tab (Figure 10) sets up further dialing properties.

**NOTE:** This tab is the same for the North American and variable length dial string formats.

### Table 5. Advanced External Dialing tab fields — Continued

<table>
<thead>
<tr>
<th>Window Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchanges for 10-digit local numbers</td>
<td>Choose the neighboring area code, then enter the exchanges within that area code that require you to dial the area code but not a 1. Select All exchanges as 10-digit numbers if all exchanges require you to dial an area code but not a 1.</td>
</tr>
</tbody>
</table>

### Miscellaneous Tab

The Miscellaneous tab (Figure 10) sets up further dialing properties.

**NOTE:** This tab is the same for the North American and variable length dial string formats.
To configure the miscellaneous options:

- Select or clear the appropriate check boxes on the Miscellaneous tab as desired, and then click Apply to save your changes.

### Variable Length Dial String Format

If you choose the variable length dial string format, the following three tabs are active:

- **Telephone Number Display Tab (page 37)**
- **Phone Number Format Tab (page 38)**
- **Miscellaneous Tab (page 40)**

<table>
<thead>
<tr>
<th>Tab Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use text from the clipboard as the phone number when pressing the call button</td>
<td>Select to enable CAD to use text on the clipboard as the dialed number when the Make Call button on the CAD toolbar is clicked, as long as the text on the clipboard is a valid text string.</td>
</tr>
<tr>
<td>Show the dial pad when using text from the clipboard for dialing.</td>
<td>Available only if “Use text from the clipboard...” is enabled. Select to display the dial pad before dialing a number copied from the clipboard. If this check box is not selected, CAD dials the number without displaying the dial pad.</td>
</tr>
<tr>
<td>Convert text to digits in phone numbers</td>
<td>Converts phone numbers expressed in alpha characters (for example, 1-800-ANYWORD) to their numeric equivalents before dialing.</td>
</tr>
</tbody>
</table>
Telephone Number Display Tab

The Telephone Number Display tab (Figure 11) enables you to configure how phone numbers are displayed in Agent Desktop.

Figure 11. Telephone Number Display tab

The selections you make are reflected in the Sample fields. (An exception is if you enter a value in either of the “Remove first ‘n’ digits” and “Remove last ‘n’ digits” fields. In that case, the sample does not change.)

NOTE: The number of digits displayed in each section of the sample phone number is for illustration only. The samples do not reflect the number format you set up on the Phone Number Format tab.

Table 7. Telephone Number Display tab fields

<table>
<thead>
<tr>
<th>Tab Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External number format</td>
<td>Specify how you want to view calling and called phone numbers.</td>
</tr>
</tbody>
</table>
To configure the telephone number display:

- Enter data and select or clear the appropriate check boxes and radio buttons on the Telephone Number Display tab as desired, and then click Apply to save your changes.

**Phone Number Format Tab**

The Phone Number Format tab (Figure 12) enables you to establish the format for phone numbers that do not follow the North American dial string format. You can also set the maximum number of digits in an internal phone extension.

---

### Table 7. Telephone Number Display tab fields — Continued

<table>
<thead>
<tr>
<th>Tab Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>City/subscriber code</td>
<td>Specify the separator you want to display between the city code and the subscriber code.</td>
</tr>
<tr>
<td>Internal number format</td>
<td>Specify how internal phone numbers are displayed. You can include an X (extension) and remove the leading or trailing digits (in the event that extension numbers are less than 4 digits long).</td>
</tr>
</tbody>
</table>
You can establish as many formats as you want, as long as each one has a unique total length.

**Figure 12. Phone Number Format tab**

<table>
<thead>
<tr>
<th>Telephone Number Display</th>
<th>Phone Number Format</th>
<th>Miscellaneous</th>
</tr>
</thead>
</table>

- **Maximum number of digits for internal extension:** 4

<table>
<thead>
<tr>
<th>Maximum Length</th>
<th>City Code Length</th>
<th>Subscriber Code Length</th>
</tr>
</thead>
</table>

- **Add**
- **Edit**
- **Delete**

- **Use North American Dial String Formatting**
- **Use Variable Length Dial String Formatting**

**To add a new phone number format:**

1. Click Add.
   
   The Add City/Subscriber Code Lengths dialog box appears.

2. Enter the number of digits in the city code and the subscriber code, and then click OK.
   
   The numbers you entered are displayed in the phone number format pane, along with the calculated total length of the format. You cannot enter another format with the same total length.

3. Click Apply.
   
   The new phone number format is saved.

**To edit a phone number format:**

1. Choose the number format, and then click Edit.
The Edit City/Subscriber Code Lengths dialog box appears.

2. Make your changes, and then click OK.

3. Click Apply to save your changes.

The phone number format is changed.

To delete a phone number format:

1. Choose the number format, and then click Delete.

2. Click Apply to save your changes.

The phone number format is deleted.

Miscellaneous Tab

The Miscellaneous tab for the variable length dial string format is the same as the tab for the North American dial string format.

See “Miscellaneous Tab” on page 35 for a description of the Miscellaneous Tab.
Agents have a number of phone number lists available to them:

- The Recent Call List, a dynamic list of up to 100 recently-called phone numbers kept by Agent Desktop
- A personal phone book, created and maintained by the agent (and enabled/disabled by the system administrator)
- Up to 256 phone books (includes global and work flow group phone books). Each phone book supports a maximum of 3,000 directory entries.
- CAD supports in total up to 10,000 directory entries that includes global, work flow group, or personal phone book entries.
- Work flow group phone books, created by the system administrator with the work flow group Phone Book function

Global phone books, which are available to all agents, are created and maintained using the Phone Book node under the Work Flow Configuration node. Work flow groups phone books, which are available to agents only in that specific work flow group, are created and maintained using the Phone Book node under the specific work flow group’s node (Figure 13).
The global Phone Book window (Figure 14, left) enables you to set up and manage the global phone books that are shared by all agents, and to disable all phone books or just personal phone books.

The work flow group Phone Book window (Figure 14, right) enables you to set up and manage the work flow group phone books that are shared by agents in specific work flow groups.

Phone books and phone book entries are created and maintained in the Phone Book Editor dialog box (see “Creating Phone Books” on page 43).

Figure 14. Phone Book window

Using the Phone Book Filter

You can use the phone book filter to find phone book entries more easily. The filter enables you to limit the entries listed in the phone book window. You can use any of the four phone book fields to filter the entries.

To use the phone book filter:

1. In the Phone Book window, select the Filter check box.

2. From the Filter drop-down lists, select how you want to filter the entries. In the first two drop-down lists, select your filter criteria: the field to filter by, and the filter method. In the third field, enter the filter string.

For example, if you want to see all phone book entries for persons whose last name begins with “J”, select “Last Name” from the first drop-down list, “Begins with” from the second drop-down list, and enter J in the third field.

The alter operates as soon as you enter your filter string in the third field.
3. To stop filtering the phone book, clear the Filter check box or delete the filter string in the third field. The entire phone book will once again be visible.

Creating Phone Books

To set up a new phone book:

1. In the global or work flow group Phone Book window, click Edit. The Phone Book Editor dialog box appears (Figure 15).

Figure 15. Phone Book Editor dialog box

2. Enter a new phone book name in the Phone Books field, and then click Add. The name of the new phone book is added to the list of phone books.

3. Click OK. The new phone book is saved and the Phone Book Editor dialog box closes.

To add phone book entries:

1. In the Phone Book window, choose the phone book you want to edit from the drop-down list, and then click Edit. The Phone Book Editor dialog box appears.
2. Enter a first and last name, phone number, and optional note for a person or company, and then click Add to add the information to the phone book. The Phone Number field allows only these characters:

- Numbers [0–9]
- Letters [aA–zZ]
- Apostrophe [']
- Left and right parentheses [( )]
- Plus sign [+] 
- Forward slash [/]
- Colon [:]
- Period [.]
- Equal sign [=]
- Question mark [?] 
- Space

If you enter any other character you are advised you used a disallowed character. The disallowed character will be replaced by a question mark so you can change it to an allowed character.

3. Repeat Step 2 as needed to enter all entries to the phone book. When all entries are completed, click OK. Your entries are saved and the Phone Book Editor dialog box closes.

To edit phone book entries:

1. In the Phone Book window, choose the phone book you want to edit from the drop-down list, and then click Edit. The Phone Book Editor dialog box appears.

2. Choose an entry in the phone book, and then take one of these actions:

   - Click Edit, and then change the entry
   - Click Delete to delete the entry

3. When all edits are completed, click OK. Your changes are saved and the Phone Book Editor dialog box closes.

Enabling or Disabling Phone Books

Phone books can be enabled or disabled only on the global level.

To enable or disable phone books:

1. In the Phone Book window (Figure 14):
Select or clear the Disable all phone books check box to remove agent access to all global phone books.

Select or clear the Disable personal phone book check box to remove access to all agents' personal phone books.

2. Click Apply.

Importing and Exporting Phone Books

Importing and exporting phone books makes creating and maintaining large phone books (up to 3000 entries) easier than with the Phone Book Editor window. Phone books can be created and edited in any third-party application that accepts comma-separated value (CSV) files, such as a text editor or spreadsheet. Using the third-party application, you can edit exported phone books—make bulk changes (for example, changing an area code), and adding and deleting phone numbers. The updated file can then be imported into Desktop Administrator to replace the previous version.

**NOTE:** Phone books for double-byte languages must use UTF-8 character format in order for the double-byte characters to be imported successfully.

CSV File Format

The phone book CSV file contains the fields shown in Table 8.

<table>
<thead>
<tr>
<th>Field</th>
<th>Max Length</th>
<th>Permitted Characters</th>
<th>Can Be Blank?</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>100</td>
<td>Any printable</td>
<td>No</td>
</tr>
<tr>
<td>Last Name</td>
<td>100</td>
<td>Any printable</td>
<td>No</td>
</tr>
<tr>
<td>Phone Number</td>
<td>40</td>
<td>0-9, aA-zZ, '(' + / : . = ?</td>
<td>No</td>
</tr>
<tr>
<td>Notes</td>
<td>256</td>
<td>Any printable</td>
<td>Yes</td>
</tr>
</tbody>
</table>

An example of a phone book CSV file is shown below.

"First Name","Last Name","Phone Number","Notes"
"Amanda","Cohen","6511234",""
"Nicholas","Knight","612-555-1228","Sales"
"Natalie","Lambert","952-555-9876","Benefits"
"Joseph","Stonetree","651-555-7612","Manager"
A phone book CSV files must conform to this format and include the headers in the first line. During import the file is scanned for illegal characters. If any are found, they are replaced with question marks.

**NOTE:** Exported CSV files will always show each field enclosed in double quotes, as in the example above. This is to ensure that any commas or double quotes that are part of the actual field data are not mistaken for field delimiters. If your data does not include these characters, you can omit the double quotes in files you prepare for importing.

To import a phone book:

1. Make sure the phone book CSV file is formatted correctly, as specified in the section, “CSV File Format” on page 45.
2. In the Phone Book window, click Edit. The Phone Book Editor window appears (Figure 15 on page 43).
3. Click Import. The Import Select dialog box appears (Figure 16).

![Figure 16. Import Select dialog box](image)

Any CSV files located in the default folder C:\Program Files\Cisco\Desktop\config are listed. If your file is located somewhere else, click Find folder to browse to its location.

4. Select the file you want to import and then click OK. The phone book is imported and is added to the list of available phone books in the Current List pane.

The CSV file name (without the CSV suffix) becomes the phone book name. If that name is already in use, you will be asked if you want to replace the existing phone book with the imported phone book. If you do not want to replace the existing phone book, cancel the import, rename the CSV file, and try again.
NOTE: Phone book names are not case sensitive. For example, if you create a phone book named PBOOK1, and then create another phone book named pbook1, the second phone book will overwrite the first phone book.

5. Click OK to close the Phone Book Editor window.

To export a phone book:

1. In the Phone Book window, click Edit. The Phone Book Editor window appears (Figure 15 on page 43).
2. In the Current list pane, select the phone book you want to export, and then click Export. The Export Phone Book dialog box appears (Figure 17).

Figure 17. Export Phone Book dialog box

3. The default export location is the C:\Program Files\Cisco\Desktop\config folder. If you have imported or exported a phone book previously, the location you chose then is shown. If you want to export the phone book to a different location, click Browse to a different folder and navigate to that location.
4. Click OK. The phone book is exported to the selected location. The file name is the name of the phone book with the CSV file extension.
Reason Codes

Reason codes describe why an agent has changed to the Not Ready agent state or has logged out.

A maximum of 999 reason codes can be set up for CAD and CAD-BE. IP Phone Agent has a limit of 100 reason codes.

Global reason codes, which are available to all agents, are assigned using the Reason Codes node under the Work Flow Configuration node. Work flow group reason codes, which are available only to agents in that specific work flow group, are assigned using the Reason Codes node under the specific work flow group’s node (Figure 18).

Reserved reason codes (identified by [Reserved List] after the description) are predefined in Directory Services and cannot be created or deleted.

There are also Unified CCX-generated reason codes that are entered when an agent is automatically put in the Not Ready or Logout state. For instance, when an agent receives a Non-ACD call, the agent is put into the Not Ready state by Unified CCX and the reason code “32761–Non-ACD Call” is entered.
The reserved reason codes are listed in Table 9.

Table 9. Reserved reason codes

<table>
<thead>
<tr>
<th>Code</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>Logout</td>
<td>Supervisor logout.</td>
</tr>
<tr>
<td>33</td>
<td>Not Ready</td>
<td>Supervisor Not Ready.</td>
</tr>
<tr>
<td>1000</td>
<td></td>
<td>ACD voice. The system issues this reason code when an agent is in the Ready state for both voice and e-mail, and then receives an ACD call and the e-mail state changes to the e-mail Not Ready state.</td>
</tr>
<tr>
<td>32755</td>
<td>Not Ready</td>
<td>Call ended. The system issues this reason code when an agent is moved to the Not Ready state after handling a Unified CCX call.</td>
</tr>
<tr>
<td>32756</td>
<td>Not Ready</td>
<td>Device in service (phone up). The system issues this reason code when the agent’s phone comes up after it has been through a Phone Down state.</td>
</tr>
<tr>
<td>32757</td>
<td>Not Ready</td>
<td>CallManager failover. The system issues this reason code when the Unified CM fails over and the agent is moved to the Not Ready state.</td>
</tr>
<tr>
<td>32758</td>
<td>Not Ready</td>
<td>Work timer expired. The system issues this reason code when an agent’s state is changed from Work to Not Ready. This change occurs if the Work state for that agent’s Contact Service Queue (CSQ) is associated with an expired wrap-up time.</td>
</tr>
<tr>
<td>32759</td>
<td>Not Ready</td>
<td>Device out of service (phone down). The system issues this reason code if the agent’s phone crashes and that agent is placed in the unavailable state.</td>
</tr>
<tr>
<td>32760</td>
<td>Not Ready</td>
<td>Logon. The system issues this reason code when an agent logs in and is automatically placed in the Not Ready state.</td>
</tr>
<tr>
<td>32761</td>
<td>Not Ready</td>
<td>Non-ICD call. The system issues this reason code when the agent is logged on to Agent Desktop or IP Phone Agent and then receives a call that is not queued to the ACD.</td>
</tr>
<tr>
<td>32762</td>
<td>Not Ready</td>
<td>Off hook. The system issues this reason code when the agent goes off the hook to place a call. If the agent remembered to do this task the corresponding agent-triggered reason code is displayed. If the agent did not remember to do this task, the system issues this reason code.</td>
</tr>
</tbody>
</table>
Not Ready and Logout reason codes are enabled or disabled on the work flow group level.

When creating reason codes, follow these guidelines:

- Descriptions can consist of up to 40 alphanumeric characters. No punctuation or other characters are allowed.

- No agent state can contain duplicate numbers and descriptions among its reason codes.

- Reason code numbers can be any number from 0 to 999, excluding 22 and 33, which are predefined reserved reason codes. If you try to create a reason code using either of those numbers, CAD desktop applications will not function properly.

  **NOTE:** While 0 is an allowed reason code number, it is strongly recommended that you do not use it. Using 0 as a reason code can result in control failures or missing agent state events in Unified CCX.

- You cannot enable reason codes unless at least one user-defined reason code exists for Logout and one exists for Not Ready.

Table 9. Reserved reason codes — Continued

<table>
<thead>
<tr>
<th>Code</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>32763</td>
<td>Not Ready</td>
<td>Ring no answer. The system issues this reason code when the agent fails to answer a Unified CCX call within the specified timeout period.</td>
</tr>
<tr>
<td>32764</td>
<td>Logout</td>
<td>CRS failover. The system issues this reason code when the active server becomes the standby server and the agent loses connection to the Unified CCX platform.</td>
</tr>
<tr>
<td>32765</td>
<td>Logout</td>
<td>Connection down. The system issues this reason code when IP Phone Agent or Agent Desktop crashes due to any reason or if the connection is disrupted.</td>
</tr>
<tr>
<td>32766</td>
<td>Logout</td>
<td>Force logout (close Agent Desktop). The system issues this reason code when an agent closes Agent Desktop without logging off.</td>
</tr>
<tr>
<td>32767</td>
<td>Logout</td>
<td>Force login (agent relogin). The system issues this reason code when an agent is already logged in to one device (computer or phone) and then tries to relogin to a second device.</td>
</tr>
</tbody>
</table>
Assigning Reason Codes

To assign global reason codes:

1. Select Work Flow Configuration > Reason Codes node in the navigation tree to display the Reason Codes window (Figure 19, left).

2. Select the appropriate tab for the type of reason codes you want to assign: Logout or Not Ready.

3. From the Available Reason Codes List, select the reason codes you want to make available to all agents, and then click the right arrow button to move them to the Global Reason Codes List.

4. Click Apply.

To assign work flow reason codes:

1. Select the Reason Codes node under the desired work flow group in the navigation pane to display the Reason codes window (Figure 19, right).

2. Select the appropriate tab for the type of reason codes you want to assign: Logout or Not Ready.
3. From the Available Reason Codes List, select the reason codes you want to make available to agents in that work flow group, and then click the right arrow button to move them to the Work Flow Group List.

4. Select the Enable Logout Reason Codes or Enable Not Ready Reason Codes check box to enable that type of reason code for the agents in that work flow group. This includes any global reason codes set up.

5. Click Apply.

Enabling or Disabling Reason Codes

Reason codes can be enabled or disabled only on the work flow group level, and must be done individually for every work flow group.

To enable or disable reason codes:

1. Select the Reason Codes node under the work flow group whose reason codes you want to enable or disable.

2. Select the appropriate tab and then select or clear the Enable Logout Reason Codes or Enable Not Ready Reason Codes check box.

3. Click Apply.
Wrap-up Data

Wrap-up data descriptions are used by contact centers for purposes such as tracking the frequency of different activities and identifying the account to which to charge a call, among others. Wrap-up data is set up and maintained, and automated state changes are enabled, using the Wrap-up Data window. Wrap-up data descriptions are used for both calls and e-mails.

There is no limit on how many wrap-up data descriptions can be set up for CAD and CAD-BE. IP Phone Agent has a limit of 100 wrap-up data descriptions.

NOTE: CAD, CAD-BE, and IP Phone agents must log out, exit, and restart the application for changes to take effect.

Global wrap-up data descriptions, which are available to all agents, are created and assigned using the Wrap-up Data under the Work Flow Configuration node. Work flow group wrap-up data descriptions, which are available to agents only in that specific work flow group, are created and assigned using the Wrap-up Data node under the specific work flow group’s node (Figure 20).

Figure 20. Global and work flow wrap-up data nodes

[Diagram of Wrap-up Data nodes]

Global wrap-up data node

Work flow wrap-up data node
In Agent Desktop, CAD-BE, and IP Phone Agent, the agent selects the appropriate wrap-up data description at the beginning of the wrap-up work time for a call or sent e-mail.

When creating wrap-up data descriptions, follow these guidelines:

- Descriptions can consist of up to 39 alphanumeric characters. No punctuation or other characters are allowed.

  **NOTE:** For Chinese, Japanese, and Korean localized sites, descriptions might not appear correctly in IP Phone Agent due to the phone limitations on multi-byte characters.

- Duplicate descriptions are not allowed.

**Creating Wrap-up Data Descriptions**

You can create and modify wrap-up data descriptions on both the global and work flow group level.

**To create a wrap-up data description:**

1. Select the global or work flow group Wrap-up Codes node in the navigation tree to display the Wrap-up Codes window (Figure 21).

![Wrap-up Data window](image.png)

Figure 21. Wrap-up Data window
2. Click Modify List to display the Wrap-up Data Editor dialog box (Figure 22).

Figure 22. Wrap-up Data Editor dialog box

3. Type the new wrap-up data description in the Description field, and then click Add. The wrap-up data description is added to the Wrap-up Data list.

4. Click OK close the dialog box, and then click Apply to save your changes.

To edit a wrap-up data description:

1. Select the global or work flow group Wrap-up Data node in the navigation tree to display the Wrap-up Data window (Figure 21).

2. Click Modify List to display the Wrap-up Data Editor dialog box (Figure 22).

3. Double-click the wrap-up data description you want to edit.

4. In the pop-up dialog box, edit the description as desired and then click OK.

5. Click OK to close the Wrap-up Data Editor dialog box, and then click Apply to save your changes.
To delete a wrap-up data description:

1. Select the global or work flow group Wrap-up Data node in the navigation tree to display the Wrap-up Data window (Figure 21).
2. Click Modify List to display the Wrap-up Data Editor dialog box (Figure 22).
3. Select the wrap-up data description you want to delete, and then click Delete.
4. Click OK to close the dialog box, and then click Apply to save your changes.

Assigning Wrap-up Data Descriptions

Wrap-up data descriptions can be assigned at the global and at the work flow group level. Global wrap-up data descriptions are available to all agents. Work flow group level wrap-up data descriptions are available only to the agents in that specific work flow group.

To assign global wrap-up data descriptions:

1. Select the global Wrap-up Data node in the navigation tree to display the Wrap-up Data window (Figure 21, left).
2. From the Available Wrap-up Descriptions list, select the descriptions you want to make available to all agents, and then click the right arrow button to move them to the Global Wrap-up Descriptions list.
3. Click Apply.

To assign work flow wrap-up data descriptions:

1. Select the Wrap-up Data node under the desired work flow group in the navigation pane to display the Wrap-up Data window (Figure 21, right).
2. From the Available Wrap-up Data list, select the descriptions you want to make available to agents in that work flow group, and then click the right arrow button to move them to the Work Flow Wrap-up Data list.
3. Select the Enable Wrap-up Data check box to enable wrap-up data for the agents in that work flow group. This includes any global wrap-up data descriptions set up.
4. Click Apply.

Enabling or Disabling Wrap-up Data

Wrap-up data can be enabled or disabled only on the work flow group level.

To enable or disable wrap-up data:

1. Select the Wrap-up Data node under the work flow group whose wrap-up data descriptions you want to enable or disable.
2. Select or clear the Enable Wrap-up Data check box.
3. Click Apply.

**Automatic State Changes**

By default, automatic state changes are not enabled. After agents enter wrap-up data, they remain in the Work state for the length of time set for the wrap-up timer or until they change states manually, whichever happens first. (The wrap-up timer value is configured in Unified CCX Administration.)

If automatic state changes are enabled, agents are automatically changed from the Work state to the Ready state after they enter wrap-up data.

Automatic state changes can be enabled or disabled only on the work flow group level.

**To enable or disable automatic state changes:**

1. Select the Wrap-up Data node under the work flow group whose automatic state changes you want to enable or disable.
2. Select or clear the Enable Automatic State Change check box.
3. Click Apply.
Work Flow Groups

Use the Work Flow Groups function to create and configure agent work flow groups (Figure 23).

Under the Work Flow Groups node are individual work flow groups. Initially there is a default work flow group, which can be edited, renamed, or deleted. You can also create additional work flow groups.

When you click on a work flow group, the elements that make up and apply only to that work flow group appear as subnodes:

- Enterprise Data—Configure enterprise data on the agent desktop.
- Reason Codes—Assign reason codes.
- Wrap-up Data—Assign wrap-up data.
- Phone Book—Create and edit phone books.
■ CAD Agent—Configure the user interface and voice contact work flow, and agent management work flows for agents using Agent Desktop.
■ CAD-BE Agent—Configure the user interface and voice contact work flows for agents using Agent Desktop—Browser Edition.
■ IP Phone Agent—Enable agent-initiated recording for agents using the Cisco IP Phone Agent service.

Maintaining Work Flow Groups

You can add, delete, or edit work flow groups under the Work Flow Groups node.

NOTE: If you choose to delete the default work flow group, make sure that all agents are assigned to a custom work flow group you have set up. If an agent is not assigned to a work flow group, and there is no default work flow group, that agent will not be able to start Agent Desktop.

To add a new work flow group:

1. In the Navigation pane, choose the Agents node or work flow group subnode (for example, under Agents, choose the Default work flow group).
2. From the menu bar, choose File > New. The Work Flow Group Name Editor dialog box appears (Figure 24).

Figure 24. Work Flow Group Name Editor dialog box

3. Enter a new work flow group name. The name can be a maximum of 64 characters long.
If you want to copy an existing work flow group, select the “Copy the following work flow group” check box and choose a work flow group from the drop-down list.

4. Click OK. The new work flow group appears in the Navigation pane. The new work flow group has the same setup as the default work flow group.

To delete an existing work flow group:

1. In the Navigation pane, choose the work flow group you want to delete.

2. From the menu bar, choose File > Delete.

   You are warned that all agents belonging to the work flow group you want to delete must be reassigned to other work flow groups. Click Yes to confirm the deletion, or No to cancel it. If you do not reassign the agents, you will not be able to delete the work flow group.

3. Click OK to close the dialog box.

To rename a work flow group:

1. Add a new work flow group.

   Name the new work flow group with the name you want the existing work flow group to be renamed.

   Select the “Copy the following work flow group” check box and select the existing work flow group from the drop-down list.

2. Delete the old work flow group.
Enterprise Data

The Enterprise Data window enables you to:

- Configure Agent Desktop so that agents in the selected work flow group can edit enterprise data
- Set thresholds for call duration at a particular type of device while a call is in the contact center

Data

The Data tab (Figure 25) controls whether or not an agent in the work flow group is allowed to edit the enterprise data displayed in Agent Desktop.

Figure 25. Data tab

To enable enterprise data editing:

- Select the Allow agent to edit Enterprise Data check box, and then click Apply.
Call Activity

The Call Activity tab (Figure 26) enables you to set the thresholds for the selected work flow group for call duration at a particular type of device (CSQ and Agent) while a call is in the contact center.

If a call remains at a device longer than the defined Caution or Warning threshold, a Caution or Warning icon is displayed next to the device name in the Agent Desktop call activity pane.

To set up call activity thresholds:

1. On the Call Activity tab, enter the threshold times as desired.
   - Enter values in the Warning fields before entering values in the Caution fields. If you enter values in the Caution fields first, Desktop Work Flow Administrator automatically enters values one second greater in the Warning fields.
   - The Warning threshold value must be greater than the Caution threshold value. If you enter a greater value in the Caution field, Desktop Work Flow Administrator automatically changes it so that it is one second less than the Warning value.
Maximum Warning value: 59 minutes, 59 seconds
Maximum Caution value: 59 minutes, 58 seconds

2. Click Apply to save your changes.
CAD, CAD-BE, and IP Phone Agent

The CAD Agent, CAD-BE Agent, and IP Phone Agent nodes enable you to configure various functions for each type of agent within the selected work flow group.

CAD Agent

You can configure the following for agents using Agent Desktop:

- User Interface (page 65)
- Voice Contact Work Flows (page 81)
- E-Mail Contact Work Flows (page 90)
- Agent Management Work Flows (page 91)

CAD-BE Agent

You can configure the following for agents using CAD-BE:

- User Interface (page 65)
- Voice Contact Work Flows (page 81)

IP Phone Agent

The Recording node under the IP Phone Agent node enables agent-initiated recording for agents who use the IP Phone Agent service.

**NOTE:** If your CAD system is configured to use Unified CM-based monitoring, the IP Phone Agent node is not available.

When enabled, the IP Phone Agent service has soft key options for starting and stopping recording. The IPPA agent can then record his or her own phone conversations, and these recordings can be reviewed by the supervisor using Supervisor Record Viewer.

See the *Cisco IP Phone Agent User Guide* and the *Cisco Supervisor Desktop User Guide* for more information.

**To enable IPPA agent-initiated recording:**

1. Select the Enable IPPA Recording check box.
2. Click Apply to save your changes.
User Interface

The User Interface window enables you to configure the appearance and behavior of Agent Desktop (when accessed under the CAD Agent node) and CAD-BE (when accessed under the CAD-BE Agent node).

**NOTE:** The User Interface windows for CAD Agent and CAD-BE Agent are slightly different to allow for the differences in the two applications. The following section will discuss the CAD Agent version and note where it is different for CAD-BE Agent.

**Toolbar**

The Toolbar tab (Figure 27) enables you to:

- Adding and Removing Toolbar Buttons (page 65)
- Associating Actions with Task Buttons (page 66)
- Changing a Task Button’s Hint (page 67)
- Customizing Button Icons (page 67)
- Show Data Fields (page 69)

**Figure 27. Toolbar tab**

![Toolbar tab](image)

**CAD Agent version**

**CAD-BE Agent version**

**Adding and Removing Toolbar Buttons**

The pane on the left of the Toolbar tab displays the buttons that are available to be used on the Agent Desktop toolbar. Buttons that are assigned show an icon next to them; unassigned buttons do not show an icon.
You cannot change the hint or the shortcut key combination on any of the standard buttons, or assign an additional action to them. You can, however, customize the icon displayed on the button (see “Customizing Button Icons” on page 67).

**To add a button to the toolbar:**

1. In the list of buttons, select the available button you want to add.
2. Select the Visible check box, and then click Apply.

**Removing a button from the toolbar:**

1. In the list of buttons, select the button you want to remove.
2. Clear the Visible check box, and then click Apply.

**Adding the Cisco Unified Outbound Dialer Toolbar**

The Cisco Unified Outbound Dialer feature is available only for Agent Desktop Premium version users. You cannot add the Outbound Dialer toolbar to CAD-BE.

**To add an Outbound Dialer toolbar to Agent Desktop:**

- In the Outbound Dialer Mode section, select the Direct Preview dialing mode check box and then click Apply. The Outbound Dialer buttons are added to the Agent Desktop toolbar.
  
  For more information, see “Cisco Unified CCX Outbound Preview Dialer” on page 141.

**Associating Actions with Task Buttons**

You can associate as many actions with a task button as you need. The actions are executed sequentially in the order they are listed in the Actions window.

**NOTE:** Bear in mind the amount of time it takes to execute actions. Generally, a maximum of two or three actions per task button is recommended.

The default task buttons display icons of the numbers 1 through 10. You can customize these icons if you need.

**To associate an action with a task button:**

1. Select a task button from the list of available buttons.
2. Select the Visible check box. The Actions pane and its associated buttons become enabled.
3. Under the Actions pane, click Add. The Select Action window appears.
4. Select the action you want to associate with the button.
You can select an existing action or set up a new action. (See “Actions” on page 96 for more information on setting up new actions.)

5. Click OK. The Toolbar tab is displayed.

6. Type a short description of the action in the Hint field. You can replace only the hint; you cannot change the shortcut key combination.

7. Repeat Steps 3–6 if you want to add other actions to the same task button.

8. Click Apply to save your changes.

Changing a Task Button’s Hint

You can change the hint (the text an agent sees when the mouse hovers over a button) associated with a task button.

You cannot change the hint associated with a standard button, or change the shortcut key combination of any button.

To change a task button’s hint:

1. Select the button whose hint you want to change.
2. In the Hint field, type the hint you want displayed to the agent.
3. Click Apply to save your changes.

Customizing Button Icons

Buttons can be customized by applying different icons to them. A library of available icons is supplied with Desktop Work Flow Administrator, or you can use icons of your own.

If you use your own icons, when applied to a button the icon file is written to Directory Services so it is available to all instances of Agent Desktop.

Custom icons must meet the following specifications.

■ ICO format
■ 50 Kb file size limit
■ 16 × 16 or 32 × 32 pixels
■ up to 256 colors

To customize an icon:

1. Choose the button whose icon you want to customize.
2. Click Customize Icon. The Choose Icon dialog box appears (Figure 28).

Figure 28. Choose Icon dialog box

3. Choose an icon. The icon is displayed in the Preview area.
   You can also click Browse to navigate to another location if you want to use your own icon.
4. Click OK. The button is displayed with the new icon on it in the button list.

To reset a button icon:

1. Select the button that has the icon that you previously customized. The Reset button becomes enabled.
2. Click Reset. The original icon is displayed in the button list.
3. When you are finished, click Apply to save your changes.
Show Data Fields

The Show Data Fields tab (Figure 29) configures the data fields that appear in the contact appearance pane in Agent Desktop and CAD-BE, and enables you to rename data fields. It also allows you to enable/disable incrementing duration fields in CAD-BE.

Figure 29. Show Data Fields tab

NOTE: Agent Desktop and CAD-BE agents must log out, exit, and log in again for changes to take effect.

Configuring and Renaming Data Fields

The left pane displays the fields that appear in Agent Desktop and CAD-BE. The right pane displays the available fields.

NOTE: The left pane must contain at least one field.

To configure data fields:

1. Use the left and right arrows to move the available fields between the left and right panes, and the up and down arrows to set the left-to-right order in which the fields will appear.

2. Click Apply to save your changes.
To rename a data field:

1. Double-click the field you want to rename. The Rename dialog box appears (Figure 30).

![Rename dialog box](image)

2. Enter a new name and then click OK.

**Show Duration**

For CAD-BE agents, select the Show Duration check box to enable the Duration field in CAD-BE to increment during a call. By default this option is enabled. However, a continually changing field can cause difficulties for screen readers, so this field might be disabled for agents who are visually impaired.

For CAD agents, this feature is enabled/disabled in the Agent Desktop Preferences.
Miscellaneous

Use the Miscellaneous tab (Figure 31) to configure other user interface options. Select or check your desired settings, and then click Apply to save your changes.

Figure 31. Miscellaneous tab

![Miscellaneous tab](image)

CAD Agent version

CAD-BE Agent version
Browser Setup

Use the Browser Setup tab (Figure 32) to configure the Integrated Browser portion of Agent Desktop and CAD-BE. On this tab, you can do the following tasks:

- Enable/disable the integrated browser window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Behavior</td>
<td>Specify how you want the Agent Desktop window to behave. The default setting is Agent’s Choice.</td>
</tr>
<tr>
<td></td>
<td>• Normal. The window appears when calls are present and minimizes when idle.</td>
</tr>
<tr>
<td></td>
<td>• Keep Open. The window is always visible, but can be hidden by other open applications.</td>
</tr>
<tr>
<td></td>
<td>• Always on Top. The window is always visible and on top of other open applications.</td>
</tr>
<tr>
<td></td>
<td>• Stealth. The window appears as an icon in the system tray.</td>
</tr>
<tr>
<td></td>
<td>• Agent’s Choice. Behavior is set locally by the agent. The local setting persists until reset or until you choose something other than Agent’s Choice. On the agent’s desktop, the default setting is Normal.</td>
</tr>
</tbody>
</table>

**NOTE:** When you select the Always on top or the Agent’s Choice window behavior, you cannot select the real time displays and dial pad always on top options.

<table>
<thead>
<tr>
<th>Window Options*</th>
<th>Select to keep the Real time displays and dial pad always on top. The window remains open when idle and on top of all other open applications.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro Hot Key</td>
<td>Specify the key you want to use to pause macro recording and display the Suspend Macro Recording dialog. The default is F2.</td>
</tr>
<tr>
<td>Rules and Actions only apply to the first call appearance</td>
<td>Select to invoke rules processing only for the oldest (top) call appearance. If the check box is not selected, rules processing is invoked for all inbound calls.</td>
</tr>
</tbody>
</table>

* If both real time displays and dial pad options are selected to be always on top, the most recent of the two windows an agent open will be on top.
- Set the default web page displayed by the browser
- Enable up to 10 browser tabs
- Enable/disable popups to be displayed as a regular Internet Explorer popup window instead of a new tab in the integrated browser
- Enable/disable agents’ access to other websites
- Add work sites (or “favorites”) so agents can quickly access frequently-used websites
- Enable/disable hyperlink dialing

Some of the features listed above do not apply to CAD-BE.

Figure 32. Browser Setup tab

Enabling the Integrated Browser

You can enable/disable the integrated browser in Agent Desktop/CAD-BE by selecting or clearing the Enable Integrated Browser check box at the bottom of the Browser Setup tab.

Enabling Access to Other Websites

You can enable/disable an agent’s access to other websites by selecting or clearing the Allow Address Editing check box. When selected, the Address field appears in the integrated browser window, and agents can enter the URL of a website they want to view. When disabled, the Address field does not appear in the integrated browser window.
Enabling Hyperlink Dialing

You can enable/disable dialing of phone numbers on websites displayed in the Agent Desktop integrated browser by selecting or clearing the Enable Hyperlink dialing check box.

**NOTE:** The Enable Hyperlink dialing option is not available for CAD-BE.

When enabled, CAD agents can dial phone numbers that are displayed as a hyperlink on a web page by clicking on the phone number. When clicked, the phone numbers are dialed using the agent’s phone. Phone numbers must conform to the following rules in order to become hyperlinks:

- The phone number must be 10 digits long and use the North American dial string format:
  `<area code> <exchange> <subscriber number>`
- The phone number can have parentheses around the area code, and use any combination of spaces, hyphens, and periods in the phone number.
- Numbers shorter than 10 digits, such as local numbers without area codes or phone extensions, cannot be dialed.
- The phone number cannot contain alpha characters. For instance, the phone number 800-GET-PZZA cannot be dialed.
- Phone numbers that are actually image files or are populated from databases cannot be dialed.
- Some web sites hide hyperlinks; the phone number might not look like it is hyperlinked, but it actually is and can be dialed.

For more information, see “Dialing Hyperlinked Phone Numbers” in the Cisco CAD User Guide.

Configuring the Number of Browser Tabs

Choose 0 to 10 in the Number of Work Flow Browsers field to set how many browser tabs appear in Agent Desktop (this feature is not available in CAD-BE). If you choose 0, only the supervisor push page tab appears—it is always enabled. If you choose 1 to 10, that many tabs in addition to the supervisor push page tab appear.

Work flow HTTP actions can be set up to display web pages in a specific browser tab. See “HTTP Action” on page 109 for more information.
Enabling Popups to be Displayed in a New Window

You can enable/disable popups to be displayed as regular Internet Explorer popup windows in Agent Desktop by selecting or clearing the Popups In New Windows check box. When enabled, popups are displayed as regular Internet Explorer popup windows. When disabled, popups are displayed as new tabs in the integrated browser.

NOTE: If popups are enabled, an administrator cannot control the resulting Internet Explorer window. The agent might be able to gain full navigational control of the resulting browser window, including the address bar.

Setting Up the Home Page

A home page is the website that appears in the integrated browser when Agent Desktop or CAD-BE is started. The default website is www.cisco.com. If no home page is configured (the default is deleted), the integrated browser tab is blank.

To configure a home page:

1. From the Browser Tab drop-down list, select the tab where you want the home page to appear.
2. In the Home Page field, type the web address (URL) of the website you want to appear by default in the integrated browser.
3. Click Update.
4. Repeat steps 1 through 3 for each tab as desired.
5. Click Apply to save your changes. The home page is set.

Setting Up Work Sites

A work site is a website that is frequently accessed by agents to assist them in their jobs. They are similar to the “favorites” you can set up in a web browser.

Work sites you set up appear in a drop-down list in the agent’s integrated browser. When the agent selects a work site from the list, it is displayed in the integrated browser window. This allows the agent quick access to the site without having to type its address in the (optional) Address field.

To add a work site:

1. In the Site Name field, type the name of the website you want to add as a work site.
2. In the URL field, enter the web address of the website.
3. Click Add. The work site is added to the list in the Work Sites pane.
4. Click Apply to save your changes.
To update a work site:

1. In the Work Sites field, select the work site you want to update. The information for the website appears in the Site Name and URL fields.
2. Edit the information as needed, and then click Update. The updated information appears in the Work Sites pane.
3. Click Apply to save your changes.

To delete a work site:

1. In the Work Sites pane, select the work site you want to delete. The information for the website appears in the Site Name and URL fields.
2. Click Delete. The work site is deleted from the Work Sites pane.
3. Click Apply to save your changes.

Remote Access

The Remote Access tab (Figure 33) is used to enable the IPC Receive Event feature and configure the port used by the feature. The IPC Receive Event feature is available only in the Premium bundle.
NOTE: The Remote Access feature is not available for CAD-BE.

An IPC Receive Event occurs when a third-party application sends a message to Agent Desktop over a UDP socket. These messages must adhere to a predefined XML schema (see examples below) and cannot exceed 4000 bytes.

Unlike work flow actions, IPC Receive Event actions do not require configuration or setup in Desktop Administrator. All attributes that IPC Receive Event actions require in order to execute are a part of the IPC Receive Event message content. All incoming IPC Receive Event messages must adhere to a strict predefined XML schema. The required schemas are defined below.

When Agent Desktop receives an IPC Receive Event message, it does not send a reply back. IPC Receive Events are queued so no messages are lost.
By default, IPC Receive Events are disabled. The default port number is Port 58000.

**NOTE:** The Remote Access action provides for receiving an asynchronous event. Even if the event is solicited by an IPC Action request being sent out, the request might never be delivered, and there is no assurance that a response will arrive because of the nature of UDP.

Five actions are supported by the IPC Receive Event:

- IPC Make Call Action (page 78)
- IPC High Priority Chat Action (page 78)
- IPC Record Action (page 79)
- IPC Agent Notification Action (page 79)
- IPC Set Variable Action (page 80)

**IPC Make Call Action**

For the IPC Make Call action to be successful:

- The agent must be in the Not Ready state
- There can be no call appearance present in Agent Desktop
- The Make Call dialog box must be closed (if it is open, the action will close it)

The message sent to Agent Desktop must conform to this XML format. **Bold** text indicates a variable that must be replaced with your own values.

```xml
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
  <IPCMakeCallAction>
    <ActionName>IPC Make Call Action</ActionName>
    <PhoneNumber>2961</PhoneNumber>
    <DisplayError>true</DisplayError>
  </IPCMakeCallAction>
</IPCActions>
```

**IPC High Priority Chat Action**

For the IPC High Priority Chat action to be successful, the agent must be logged in.

The message sent to Agent Desktop must conform to this XML format. **Bold** text indicates a variable that must be replaced with your own values.

```xml
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCHighPriorityChatAction>
  <ActionName>IPC High Priority Chat Action</ActionName>
  <MessageText>Need help from supervisor</MessageText>
</IPCHighPriorityChatAction>

IPC Record Action

For the IPC Record action to be successful:

- A call appearance must be present in Agent Desktop
- The call must be connected, on hold, or conferenced
- The call must be the first call appearance listed in Agent Desktop

The message sent to Agent Desktop must conform to this XML format. The action supports two commands: start and stop.

```xml
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
  <IPCRecordAction>
    <ActionName>IPC Record Action</ActionName>
    <Command>start</Command>
    <DisplayError>true</DisplayError>
  </IPCRecordAction>
</IPCActions>
```

IPC Agent Notification Action

For the IPC Agent Notification action to be successful, the agent must be logged in.

The message sent to Agent Desktop must conform to this XML format. Bold text indicates a variable that must be replaced with your own values.

```xml
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
  <IPCAgentNotificationAction>
    <ActionName>IPC Agent Notification Action</ActionName>
    <MessageText>Go to Not Ready state!</MessageText>
  </IPCAgentNotificationAction>
</IPCActions>
```
**IPC Set Variable Action**

For the IPC Set Variable action to be successful, the agent must be logged in.

The IPC Set Variable action receives data values (for example, Cisco Outbound Dialer variables prefixed with “BA”) from a third-party application in UDP format. The action sends these data values to the CTI server.

All variables (ECC variables, call variables, and Outbound Dialer variables) can be set with this action.

The message sent to Agent Desktop must conform to this XML format. **Bold** text indicates a variable that must be replaced with your own values.

```xml
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
    <IPCSetAddressAction>
        <ActionName>IPC Set Variable Action</ActionName>
        <Variable>BAResponse</Variable>
        <DataValue>03/05/2009 05:45</DataValue>
    </IPCSetAddressAction>
</IPCActions>
```
Voice Contact Work Flows

Voice contact work flows manage agent activity based on voice call events. Once a call is classified it is further filtered according to events, rules, and actions. Voice contact work flows (Figure 34) are available to Agent Desktop and CAD-BE agents.

Figure 34. Voice Contact Work Flows flow chart

For example, a voice contact work flow could be set up as follows:

1. A call comes into the contact center and is routed to an agent in the Ready state.
2. The Voice Contact Classification filter determines which work flow to select. It examines the inbound call’s enterprise data (original dialed number) and determines that it is a call for Product A technical support and thus meets the data conditions of Work Flow 1. The call is now subject to the second layer of filtering set up in Work Flow 1.

3. Work Flow 1 says that any ringing event on the Product A support line triggers an HTTP action. This action takes the customer-entered account information from the IVR (part of the call’s enterprise data) and pops a web page in Agent Desktop’s or CAD-BE’s integrated browser that displays the customer’s account information to the agent.

4. The agent answers the phone call and is ready to assist the customer.

Creating a Voice Contact Work Flow

The general procedure for creating a voice contact work flow is as follows:

1. Set up a new voice contact classification filter:
   a. Select the type of call the work flow applies to—inbound, outbound, or all calls.

   **NOTE:** An Outbound Dialer customer call can appear as inbound or outbound. Therefore, when creating an Outbound Dialer work flow, select **all calls** as your voice classification filter.

   b. If required, further classify the call by specifying it must meet various data field conditions.

2. Set up the second level of filtering:
   a. Select the call or agent state event—Ringing, Answered, Work, or Dropped.
   
   b. If required, set up one or more rules with data field conditions that the call must meet.
   
   c. Set up one or more actions that will take place if the call or agent event meets the rules’ data field conditions.

3. Set up as many second level filters as needed for calls selected by the first level filter. You can set up rules and actions for each of the filtered call’s call or agent events.

   **NOTE:** It is possible to set rules and conditions that are contradictory so that a work flow cannot function. Desktop Work Flow Administrator does not check a work flow’s logic and validity. If a work flow fails to operate as expected, make sure that the rules and conditions you set up are logically valid.
Setting Up a New Voice Contact Classification

When you select the Voice Contact Work Flow node in the navigation tree, the Voice Contact Work Flow List window is displayed. This window shows all the existing voice contact work flows, and enables you to edit them or to set up new ones.

The Voice Contact Classification is the first level of filtering in a voice contact work flow.

To set up a new voice contact classification:

1. In the Voice Contact Work Flow List window, click Add. The New Work Flow Name dialog box is displayed.

2. Enter a name for your new voice contact work flow, and then click OK. The Edit Voice Contact Classification dialog box appears (Figure 35). Note that the work flow name you just created is shown in the dialog box.

Figure 35. Edit Voice Contact Classification dialog box

3. Set up the criteria for the first level filter in this dialog box.
   a. Select the type of call you want the filter to apply to from the drop-down list: inbound calls, outbound calls, or all calls.

   NOTE: There is also the option to disable the work flow. You can select this option later on if and when you want to disable the work flow, but to keep the work flow on file for use at a later date.

   b. Apply up to three data field conditions. Click Edit to display the Data Field Condition dialog box. For information on setting up a data field condition, see “Data Field Conditions” on page 85.
c. Select if you want the filter to apply when ALL conditions are true, or if ANY conditions are true.

4. Click OK to complete setting up the first level filter in the new voice contact work flow.

**Setting Up a New Work Flow**

After a new voice contact classification is created, Desktop Work Flow Administrator takes you to the Voice Contact Work Flow window (Figure 36). In this window you set up the second level of filtering, consisting of events and rules, and the resulting actions for your new voice contact work flow.

**Figure 36. Voice Contact Work Flow window**

When an event occurs, the rules associated with the event are evaluated in the order they are listed in the Rules pane. When a rule is met, the actions associated with that rule are executed in the order they are listed in the Actions pane. Subsequent rules are not evaluated.

If no rules are met, the default rule governs, and all actions associated with the default rule are executed. Default rules cannot be changed or deleted.
The default action might be <no action>.

**To set up a new work flow:**

1. Select the event that triggers the work flow from the Event pane. The available events are:
   - Ringing. The agent’s phone rings.
   - Answered. The agent answers the phone.
   - Dropped. The call is terminated.
   - Work. The agent transitions to the Work agent state.

2. Under the Rules pane, click New to set up a new rule. The New Rule Name dialog box appears.

3. Enter the name of the new rule, and then click OK. The fields in the Current Rule Conditions section of the window are enabled.

4. Add up to 3 data field conditions (see “Data Field Conditions” on page 85 for more information) and specify when the actions should be executed—when any one of the data field conditions is met, or when all of the data field conditions are met.

   When a data field condition is established, the Enable Rule check box is automatically selected.

   **NOTE:** You cannot use a route point phone number when configuring a rule for inbound ACD calls.

5. Under the Actions pane, click Add to choose one or more actions to run when the event occurs and the rules are met.

   You can select an existing action, or create a new action. If the action you select cannot be associated with the event, you will receive an error message. See “Actions” on page 96 for more information.

6. Repeat steps 1 through 5 for as many events as desired.

7. When you are finished associating events with rules and actions, click Apply to save the new voice contact work flow.

**Data Field Conditions**

Data field conditions are criteria that a call’s selected enterprise data fields must meet in order for a voice contact classification or a work flow rule to be enforced.

You can configure up to 3 data field conditions for a voice contact classification filter and for a work flow rule. You specify if all the data field conditions must be met (an AND statement) or if any of the data field conditions must be met (an OR statement).
To do this you use the Data Field Condition dialog box (for a voice contact classification) (Figure 37) or the Current Rule Conditions section of the Voice Contact Work Flow window (for a work flow rule).

Figure 37. Data Field Condition dialog box

To set up data field conditions:

1. In the Voice Contact Classification dialog box, click Edit. In the Voice Contact Work Flow window, add a new rule and then click Edit in the Current Rule Conditions section of the window.

2. Select a data field from the Data Field drop-down list.

   The Data Field lists all the enterprise data fields used in your system.

   Not all data fields are available for all events, for instance, Calling# and Called# are not available for the Ringing event.

3. Specify one of the data field filters:

   - Is Empty. There is no data in the data field.

   - Is Not Empty. There is data in the data field.

   - Is In the List. The data field is compared to the list you set up in the List pane to determine if it is in that list. Click Add to add an item to the list of strings. Strings are not case sensitive. You can use wild cards (* and ?) to
— Is Not in the List. The data field is compared to the list you set up in the List pane to determine if it is not in that list. Click Add to add an item to the list of strings. Strings are not case sensitive. You can use wild cards (*) and (?) to simplify your list. See “Wild Card Searches” on page 87.

— Length of Data. The length of the data field is between a minimum and maximum number of characters that you set.

4. Ensure that the Enable Condition check box is selected, and then click OK.

Wild Card Searches

You can use wild cards when entering strings in the data field conditions list pane. This enables you to avoid having to enter many strings if the strings you want to list have common elements.

Wild card characters used are the asterisk (*) and the question mark (?).

An asterisk in a string replaces any quantity of characters, as long as the other characters in the string match. For instance, ABC* matches strings that begin with ABC but end in any quantity of any characters.

A question mark in a string replaces any character, but the length of the string must be exactly as represented. For instance, ABC?? matches strings that begin with ABC and end in 2 other characters.

Double quotes around a string searches for the exact characters within the double quotes, including the wild card characters (*) and (?). For instance, “123*ABC” matches only the string 123*ABC, and does not allow the asterisk to act as a wild card.

Modifying a Voice Contact Work Flow

You can modify the default work flow and any custom work flows you create.

NOTE: The classification filter for the Default work flow is Inbound Calls. This cannot be changed.

To modify a voice contact work flow:

1. From the Voice Contact Work Flow List, select the work flow you want to modify, and then click Edit.

   ■ If you selected a custom work flow, the Edit Voice Contact Classification dialog box appears.
If you select the default work flow, the Voice Contact Work Flow window appears. The default work flow does not classify voice contacts, and so bypasses the Edit Voice contact Classification dialog box.

2. Modify the voice contact classification if desired, and then click OK to proceed to the Voice Contact Work Flow window.

3. Modify the work flow as desired, and then click Apply to save your changes.

Voice Contact Work Flows and Outbound Dialer

Cisco Unified Outbound Dialer’s Direct Preview dialing mode includes events that do not always map to work flow events. Table 11 displays how the Outbound Dialer events map to voice work flow events to assist you in creating work flows for Outbound Dialer campaigns.

Table 11. Outbound Dialer events and CAD Work Flow events

<table>
<thead>
<tr>
<th>Dialing Mode</th>
<th>Voice Contact</th>
<th>Outbound Dialer Event</th>
<th>Work Flow Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Preview</td>
<td>Outbound</td>
<td>Reserved/Offered</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accept</td>
<td>Ringing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Connected</td>
<td>Answered</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dropped</td>
<td>Dropped</td>
</tr>
<tr>
<td>Inbound &amp; Outbound</td>
<td>Reserved/Offered</td>
<td>Ringing &amp; Answered</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Accept</td>
<td>Dropped &amp; Ringing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Connected</td>
<td>Answered</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dropped</td>
<td>Dropped</td>
<td></td>
</tr>
<tr>
<td>Inbound</td>
<td>Reserved/Offered</td>
<td>Ringing &amp; Answered</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Accept</td>
<td>Dropped</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Connected</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dropped</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

Deleting a Voice Contact Work Flow

You can delete any custom work flow you create. You cannot delete the default work flow.
To delete a voice contact work flow:

1. From the Voice Contact Work Flow List, select the work flow you want to delete, and then click Delete. A popup window appears asking you to confirm you want to delete the work flow.

2. Click Yes to confirm the deletion.
E-Mail Contact Work Flows

The E-Mail Contact Work Flows node is used to enable/disable the E-Mail Review CSQ for members of the work flow group. When this setting is enabled and the agent responds to an e-mail from a CSQ associated with Review CSQ, then all the agent replies to customer e-mails are automatically routed to Review CSQ, instead of sending them directly back to the customer. Agents with skill assignment for Review CSQ are responsible for reviewing and editing the content of the response before the e-mail reply is sent to the customer.

**NOTE:** To incorporate the review process into the e-mail handling process, you must configure both the work flow group in the Work Flow Configuration node and the e-mail CSQ settings in Desktop Administrator. For more information on Review CSQ and CSQ settings, see “Configuring Contact Service Queue Settings” on page 205.

When you select the E-Mail Contact Work Flows node in the navigation tree, the E-Mail Contact Work Flows window is displayed (Figure 38). You can enable Review CSQ for the agent work flow group by selecting the check box.

![Figure 38. E-Mail Contact Work Flows](image)
Agent Management Work Flows

Agent management work flows manage agent activity based on Agent Desktop and CAD-BE activity, agent ACD states, and time of day. The work flows follow the event—rule—action behavior used by voice contact work flows. There is a major difference—there is no initial filtering similar to the voice contact classification applied to voice contacts.

The Time of Day work flow can be configured only if you have the Premium package.

For example, agent management work flows could be set up as follows:

- Every work day at 4:30, agents receive a popup message reminding them to complete their time cards.
- Whenever Agent Desktop starts up, Notepad is launched on the agent’s desktop.
- Whenever an agent enters the Ready state, the customer database is launched.
Creating an Agent Management Work Flow

The general procedure for creating an agent management work flow is as follows:

1. Select the event that triggers the work flow.
2. If the event is time of day, set up a rule with one or more data conditions that the event must meet.

**NOTE:** It is possible to set rules and conditions that are contradictory so that a work flow cannot function. Desktop Administrator does not check a work flow’s logic and validity. If a work flow fails to operate as expected, make sure that the rules and conditions you set up are logically valid.

3. Set up one or more actions that will take place whenever the event occurs, or, if a time of day event, whenever the rule is met.

When you select the Agent Management Work Flow node, the Work Flow window appears (Figure 40).

**Figure 40. Work Flow window**
Unlike rules in voice contact work flows, rules in agent management work flows can be applied only to a time of day event, not to all events.

Not all actions are available for agent management work flows. See “Action Availability” on page 97 for more information.

**To set up a CAD activity or agent state work flow:**

1. Select the event that triggers the work flow from the Event pane. The available events are:
   - Startup. Agent Desktop/CAD-BE starts.
   - Shutdown. Agent Desktop/CAD-BE closes.
   - Ready. The agent transitions to the Ready state.
   - Not Ready. The agent transitions to the Not Ready state.
2. Under the Actions pane, click Add to choose one or more actions to run when the selected event occurs. You can select an existing action, or create a new action. See “Actions” on page 96 for more information.
3. Repeat steps 1 and 2 for as many events as desired.
4. When you are finished associating events with actions, click Apply to save the agent management work flow.

**To set up a time of day work flow:**

1. Select the Time of day event from the Event pane.
2. Under the Rules pane, click New to set up a new rule. The New Rule Name dialog box appears.
3. Enter the name of the new rule, and then click OK. The fields in the Current Rule Conditions section of the window are enabled, and the Time of Day Condition dialog box appears (Figure 41).

![Figure 41. Time of Day Conditions dialog box]

4. Set up the day or date conditions for the rule, and then click OK.
   a. To specify that an action takes place every week on certain days or at a certain time, select Day(s) of the week and then select the desired days. You must specify a time of day as well.
   b. To specify that an action takes place on a specific date, select Date, and then select the desired date from the calendar. Today’s date is circled in red. You must specify a time of day as well.

The condition you set up is automatically entered in the first Data Field Conditions line in the Current Rule Conditions section of the Work Flow window, and the Enable Rule check box is automatically selected.
5. Click Edit next to the 2 remaining Data Field Conditions fields to display the State Condition dialog box (Figure 42), and further define the rule, if desired:

- Specify if the agent is on hook or off hook
- Specify if the agent state is or is not equal to Ready or Not Ready

Figure 42. State Condition dialog box

6. Under the Actions pane, click Add to choose one or more actions to run when the event occurs and the rules are met.

You can select an existing action, or create a new action. See “Actions” on page 96 for more information.

7. Click Apply to save the new time of day work flow.
Actions

Actions are stored independently of events and rules. You can use an action in more than one event, and you can assign actions to more than one task button in Agent Desktop and CAD-BE.

While actions are processed, events are queued. It is generally a good idea to avoid long actions.

Table 12. Action types and descriptions

<table>
<thead>
<tr>
<th>Action Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Notification Action (page 103)</td>
<td>Displays a custom message popup window on the agent’s desktop when a certain event occurs</td>
</tr>
<tr>
<td>Agent State Action (page 105)</td>
<td>Sets an agent state</td>
</tr>
<tr>
<td>Call Control Action (page 107)</td>
<td>Answers, drops, conferences, transfers, or makes a call, or inputs touch tones during a call</td>
</tr>
<tr>
<td>Delay Action (page 108)</td>
<td>Inserts delay time in series of actions</td>
</tr>
<tr>
<td>HTTP Action (page 109)</td>
<td>Enables the Agent Desktop and CAD-BE integrated browser to interact with a web application</td>
</tr>
<tr>
<td>IPC Action (page 117)</td>
<td>Passes enterprise data or user-defined data from the agent desktop to a custom third-party application</td>
</tr>
<tr>
<td>Launch External Application Action (page 119)</td>
<td>Starts a third-party application</td>
</tr>
<tr>
<td>Run Macro Action (page 121)</td>
<td>Plays back a recorded sequence of keystrokes.</td>
</tr>
<tr>
<td>Set Enterprise Data Action (page 132)</td>
<td>Automatically changes an enterprise data field in Agent Desktop to a selected desktop variable or static text</td>
</tr>
<tr>
<td>Timer Action (page 134)</td>
<td>Triggers actions after a specified time has elapsed</td>
</tr>
<tr>
<td>Utility Action (page 135)</td>
<td>Run a utility, such as start and stop recording or sending a predefined, high-priority chat message to a supervisor</td>
</tr>
</tbody>
</table>
Action Availability

Not all actions are available for all events or for all types of agents. Table 13 shows which actions are available for the three types of work flows and for each type of agent (CAD agents and CAD-BE agents).

Table 13. Action availability per work flow type and agent type*

<table>
<thead>
<tr>
<th>Action Type</th>
<th>Voice Contact</th>
<th>Agent Mgmt</th>
<th>Time of Day</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CAD</td>
<td>CBE</td>
<td>CAD</td>
</tr>
<tr>
<td>Agent Notification</td>
<td>x</td>
<td>—</td>
<td>x</td>
</tr>
<tr>
<td>Agent State</td>
<td>x</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Call Control</td>
<td>x</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Delay</td>
<td>x</td>
<td>—</td>
<td>x</td>
</tr>
<tr>
<td>HTTP</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>IPC</td>
<td>x</td>
<td>—</td>
<td>x</td>
</tr>
<tr>
<td>Launch External Application</td>
<td>x</td>
<td>—</td>
<td>x</td>
</tr>
<tr>
<td>Run Macro</td>
<td>x</td>
<td>—</td>
<td>x</td>
</tr>
<tr>
<td>Set Enterprise Data</td>
<td>x</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Timer</td>
<td>x</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Utility</td>
<td>x</td>
<td>x</td>
<td>—</td>
</tr>
</tbody>
</table>

* “×” indicates the action is available: “—” indicates the action is not available.
Adding a New Action

To add a new action:

1. Access the Voice Contact Work Flow or Agent Management Work Flow window.
2. Select the event to be associated with the new action.
3. Under the Actions pane, click Add. The Select Action dialog box appears (Figure 43).

4. Choose the tab for the type of action you want to associate with the event.
5. If the action already exists, select it, and then click Add Action.
   If the action does not yet exist, click New and follow the instructions for setting up that type of action as outlined below.
6. Click Add Action. The Select Action dialog box closes and you return to the Work Flow window. The new action is listed in the Actions pane.

Figure 43. Select Action dialog box
Actions

Editing an Action

To edit an action:

1. In the Work Flow window, select the appropriate event, and then select the action you want to edit from the Actions pane.
2. Click Edit. The edit dialog box for that action appears.
3. Make your changes, and then click OK. The action is now changed.

Deleting an Action

To permanently delete an action, you must first delete it from any event it is associated with, and then delete the action itself.

To permanently delete an action:

1. In the Work Flow window, select each event. If the action you want to delete is associated with that event, select the action in the Action pane and then click Delete to remove it from that event. The action is now removed from all events.
2. Under the Actions pane, click Add. The Select Actions dialog box appears.
3. Choose the appropriate tab, and then select the action you want to delete.
4. Click Delete. The action is deleted.
5. Click Close. The Select Action dialog box closes and you return to the Work Flow window.

Importing and Exporting Actions

You can export actions associated with a specific work flow group and import them to other work flow groups. The actions are exported to any location you choose, locally or on a network drive.

NOTE: If you export actions to the default location (C:\Program Files\Cisco\Desktop\config\Action) they will be lost in the event that a client desktop is reinstalled. To avoid this, choose a location other than the CAD installation directory.

The actions you export can also be imported by other instances of Desktop Work Flow Administrator, belonging to your system or any other system, as long as those instances are the same version of Desktop Work Flow Administrator and can access the file storage folder.
Types of actions that can be exported and imported are:

- Run Macro action
- HTTP action
- IPC action
- Launch External Application action

The rules and events associated with the actions are not part of this function and cannot be exported or imported.

You can export only one action at a time. For example, if there are five actions you want to export from a work flow group, you must export each action individually.

You can add a description (limited to 255 characters) to the exported action for easier identification when importing to another work flow group.

If an imported action has the same name as an action already present in the work flow group, you will be prompted to rename the imported action.

To export a work flow action:

1. Select the work flow group whose action you want to export.

   The Import Export Work Flow Actions window appears (Figure 44).
If there are actions available for import and/or export, the Import and/or Export button is enabled. If there are no actions available for the specific action, that button is disabled.

Figure 44. Import Export Work Flow Actions window
2. Click Export. The Export Action dialog box appears (Figure 45).

![Export Actions dialog box]

3. Select the action you want to export from the Action List, and then complete the fields in the dialog box:
   - Folder Path: Select the default path shown or browse to any other local or network folder location.
   - Description (optional): Enter a description of the action. Maximum length of the description is 255 characters.

4. Click OK.

To import a work flow action:

1. Select the work flow group to which you want to import an action.

   The Import Export Work Flow Actions window appears (Figure 44).
2. Click Import. The Import Select dialog box appears (Figure 46).

![Import Select dialog box](image)

3. Navigate to the folder where actions are stored. The field is autofilled with the default path.

4. From the Action Names list, select the action you want to import to the workflow group. You can import only one action at a time.

5. Click OK.

**Agent Notification Action**

An Agent Notification action displays a custom message popup window on the agent’s desktop when a certain event occurs. For instance, when an agent logs out, a popup window reminding the agent to complete his time card could pop up on his desktop.

*To set up an Agent Notification action:*

1. Set up a new action. See “Adding a New Action” on page 98. The Select Action window appears.
2. Select the Agent Notification tab, and then click New. The Agent Notification Action Setup dialog box appears (Figure 47).

![Figure 47. Agent Notification Action Setup dialog box](image)

3. Enter an action name, select the icon you want to appear in the popup window, and then type your message.

4. Click Preview to view the popup window (Figure 48).

   **NOTE:** The title bar on the actual popup window might contain truncated text, because Windows automatically adds “Cisco Agent Desktop” to the beginning of the title bar text, and the popup window does not resize.

![Figure 48. Preview of an Agent Notification popup window](image)

5. Click OK.
Agent State Action

An Agent State action enables you to select an agent state to associate with an event.

Agent State actions can be associated only with Answered and Dropped events. The only valid agent states are Login, Logout, Ready, Not Ready, and Work.

To set up an Agent State action:

1. Set up a new action. See “Adding a New Action” on page 98. The Select Action window appears.
2. Select the Agent State tab, and then click New. The Agent State Action Setup box appears (Figure 49).
3. Enter a name for the action, select the agent state control from the drop-down list, and then click OK.

Automated Reason Codes for Agent State Changes

You can enable automated reason codes when you set up an agent state action for transitioning to Logout or Not Ready.

If you enable automated reason codes, the agent does not have to choose the appropriate reason code when an agent state action to transition to Logout or Not Ready is triggered.

To enable automated reason codes

1. Set up a new Agent State action (see “Agent State Action” on page 105) or edit an existing Agent State action (see “Editing an Action” on page 99).
2. In the Agent State Action Setup dialog box, enter a name for the action, select either AgentNotReady or AgentLogout from the Agent State Control drop-down list. The Automate Reason button appears in the dialog box (Figure 50).

![Figure 50. Agent State Action dialog box with Automate Reason button](image)

3. Click Automate Reason. The Select Reason dialog box appears (Figure 51). This dialog box contains the reason codes already set up in the system.

![Figure 51. Select Reason dialog box](image)

4. Select the reason code you want to be entered automatically when the action is triggered, and then click OK.

The default is “Agent will choose.” If you select this, the agent will have to manually enter the reason code.

The dialog box closes and the Agent State Action Setup dialog box is displayed, with the number of your chosen reason code entered in the gray box next to the Automate Reason button.

5. Click OK.
Call Control Action

Call Control actions include:

- Answer. The Answer action answers an inbound call.
- Blind conference. The Blind conference action conferences the active call with a predefined phone number.
- Blind transfer. The Blind transfer action transfers the active call directly to a predefined phone number. The call is transferred to that number and the agent is no longer connected to the call. The Blind Transfer call control action includes a configurable delay time, if one is needed. The Transfer Delay field is not enabled for any other call control action.
- Call. The Call action calls a predefined phone number.
- Drop. The Drop action disconnects an active call.
- Single-step conference. The Single-step conference action conferences the active call by specifying the number with which the agent wants to conference the call. The call is conferenced directly with the third party.
- Single-step transfer. The Single-step transfer action transfers the active call by specifying the number to which the agent wants to transfer the call. The call is transferred directly to the third party and the agent is disconnected from the call.
- Supervised conference. The Supervised conference action conferences the active call by specifying the number with which the agent wants to conference the call. The agent can either add the third party to the call without first speaking to him or her, or speak to the third party before actually completing the conference call. The agent can alternate between parties or complete the conference call.
- Supervised transfer. The Supervised transfer action transfers the active call by specifying the number to which the agent wants to transfer the call. The agent can either hang up before the third party answers, or stay on the line and speak to the third party before actually transferring the call. The agent can switch between parties or complete the call transfer.
- Touch tones. The Touch tones action enters numbers or symbols on the number pad during an active call.

These actions can be associated with an event, a rule, and a task button. For example, a task button could be configured to execute a call control action that blind transfers a call to the agent’s supervisor.

To set up a Call Control action:

1. Set up a new action. See “Adding a New Action” on page 98. The Select Action window appears.
Select the Call Control tab, and then click New. The Call Control Action Setup dialog box appears (Figure 52).

**Figure 52. Call Control Action Setup dialog box**

A blind conference call control action must be used in conjunction with rules. If no rules are configured, then the blind conference action occurs every time the event it is associated with occurs. For example, if you set up a blind conference action on an answered event and do not configure rules, it executes on every answered call. To prevent this, you must set up rules that allow the action to occur only when desired, such as only on incoming calls from the route point.

### Delay Action

Delay actions are used to add delay time between actions in a series of actions. For example, the delay action can be added to a work flow that includes a series of macros that need delay time between execution of those macros.
To set up a Delay action:

1. Set up a new action. See “Adding a New Action” on page 98. The Select Action window appears.

2. Select the Delay Action tab, and then click New. The Delay Action Setup dialog box appears (Figure 53).

3. Enter the following information:
   - A name for the delay action
   - The length of delay time, in milliseconds
   - Select the Process Events During Delay check box if you want events to be processed in the background during the delay period

4. Click OK.

HTTP Action

This action is available to Agent Desktop agents at the Premium level (Post and Get), and to CAD-BE agents at the Enhanced and Premium levels (Get only).

HTTP actions enable an agent to use call-based data to interact with a website or a web application in the Integrated Browser window.

For example, an HTTP action can be set up so the enterprise data of an incoming call is used to retrieve a customer record and display it in the Integrated Browser.

**NOTE:** For more information on HTTP requests and the HTTP protocol in general, see the website of the World Wide Web Consortium, www.w3.org.
NOTE: Keep in mind that a URL, including arguments, is limited by the HTTP service to a maximum of 2075 characters. If you create an HTTP action that results in a URL longer than that, it will not work correctly.

To set up an HTTP action:

1. Set up a new action. See “Adding a New Action” on page 98. The Select Action window appears.

2. Select the HTTP Action tab, and then click New. The HTTP Actions Setup dialog box appears (Figure 54).

3. Complete the HTTP Actions Setup dialog box as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Name</td>
<td>Enter a name for the new action.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Select the protocol to be used by the browser: http (default) or https.</td>
</tr>
<tr>
<td>Method</td>
<td>Select the http method to be used by the browser: GET (default, CAD and CAD-BE agents) or POST (CAD agents only).</td>
</tr>
<tr>
<td>Host</td>
<td>Enter the host name or IP address of the website. Do not include the http or https prefix.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port (0–65535) that the host is listening on (for http the default is 80; for https, the default is 443).</td>
</tr>
<tr>
<td>Path</td>
<td>Enter the path portion of the URL (optional). Default is blank. Do not include a leading slash.</td>
</tr>
<tr>
<td>Browser Tab</td>
<td>Select the browser tab in which you want the action results to be displayed. (For CAD-BE agents there is only 1 tab available so this field is not present.) If the tab you select is removed later, the action will be displayed in the first tab (ordinarily reserved for supervisor page push).</td>
</tr>
</tbody>
</table>
Figure 54. HTTP Actions Setup dialog box
4. Click Add to display the HTTP Request Data dialog box (Figure 55). The fields added with this dialog box make up the query or post data portion of the request. The fields are optional and are blank by default.

Figure 55. HTTP Request Data dialog box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Name</td>
<td>Enter the name of the field in the web application.</td>
</tr>
<tr>
<td>Value Type</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• DataField to use an enterprise data variable as the</td>
</tr>
<tr>
<td></td>
<td>source of the data. This is inserted in the URL</td>
</tr>
<tr>
<td></td>
<td>following the &lt;name&gt;=&lt;value&gt; format.</td>
</tr>
<tr>
<td></td>
<td>• UserDefined to use a specific string entered in the</td>
</tr>
<tr>
<td></td>
<td>Value field. This is inserted in the URL following the</td>
</tr>
<tr>
<td></td>
<td>&lt;name&gt;=&lt;value&gt; format.</td>
</tr>
<tr>
<td></td>
<td>• DataFieldOnly to insert any value selected from the</td>
</tr>
<tr>
<td></td>
<td>Valuedrop-down list without following the &lt;name&gt;=&lt;value&gt; format.</td>
</tr>
<tr>
<td>Value</td>
<td>If you selected a value type of DataField or DataFieldOnly, select the enterprise data variable from the drop-down list. If you selected UserDefined, enter the value to be used.</td>
</tr>
<tr>
<td>Test Data</td>
<td>Enter a string of test data to simulate DataField or</td>
</tr>
<tr>
<td></td>
<td>DataFieldOnly data. This field is enabled only if you</td>
</tr>
<tr>
<td></td>
<td>select a Value Type of DataField or DataFieldOnly.</td>
</tr>
</tbody>
</table>
6. Continue to build your request using the Add, Edit, and Delete buttons as needed.

7. When you have completed building the request, click Preview to view the request. Note that Desktop Work Flow Administrator has added the special characters needed for a valid HTTP request.
   - If a path is specified and there is request data, there will be a “/” after the port and a “?” after the path.
     Example: http://www.site.com:80/index.jsp?name=value
   - If a path is not specified, there is request data, and the first request data is not DataFieldOnly, there will be a “?” after the port and no “/”.
     Example: http://site.com:80?name=value
   - If a path is not specified, there is request data, and the first request data is DataFieldOnly, there will be a “/” after the port and no “?”.
     Example: http://www.site.com:80/value
   - If a path is not specified, there is more than one request data, and the first request data is DataFieldOnly, there will be a “/” after the port and no “?”.
     Example: http://www.site.com:80/value&value&value...

8. When you are satisfied your request is correctly formatted, click Test to test it using the test data you entered when adding the request data.

Reserved Characters

There are characters that must not be used in an HTTP request. These characters are listed in Table 14.

Table 14. HTTP request reserved characters

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;</td>
<td>Ampersand</td>
</tr>
<tr>
<td>@</td>
<td>At sign</td>
</tr>
<tr>
<td>\</td>
<td>Back slash</td>
</tr>
<tr>
<td>^</td>
<td>Carat</td>
</tr>
<tr>
<td>:</td>
<td>Colon</td>
</tr>
<tr>
<td>,</td>
<td>Comma</td>
</tr>
<tr>
<td>$</td>
<td>Dollar sign</td>
</tr>
<tr>
<td>“</td>
<td>Double quote</td>
</tr>
<tr>
<td>=</td>
<td>Equal sign</td>
</tr>
</tbody>
</table>
Example of an HTTP Request

To illustrate how to create a basic HTTP request, we will write a request that uses the Google search engine to search the web for “Cisco Systems.”

To learn what value names and values go into the Google search:

2. Type Cisco Systems in the search field and then click Google Search. The address bar shows the HTTP request we will create in Desktop Work Flow Administrator(Figure 56).

![Google search results page](image)

**Figure 56. Google search results page**

3. The Address bar shows this string:

www.google.com/search?ie=UTF-8&oe=UTF-8&sourceid=gd&q=Cisco+Systems&wxob=0

The portion of the string before the question mark is the host and the path. After that, all the request data is listed, separated by ampersands (&).

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td><a href="http://www.google.com">www.google.com</a></td>
</tr>
<tr>
<td>Path</td>
<td>search</td>
</tr>
<tr>
<td>Request Data</td>
<td>ie=UTF-8</td>
</tr>
<tr>
<td></td>
<td>oe=UTF-8</td>
</tr>
<tr>
<td></td>
<td>sourceid=gd</td>
</tr>
<tr>
<td></td>
<td>q=Cisco+Systems</td>
</tr>
<tr>
<td></td>
<td>wxob=0</td>
</tr>
</tbody>
</table>
To create the HTTP request:

1. Complete the HTTP Actions Setup dialog box with the information you gathered from the manual Google search (Figure 57).

   Figure 57.  Google search information entered in the HTTP Action Setup dialog box

   ![HTTP Action Setup dialog box](image)

   The values are all user-defined. The value name is on the left side of the equal sign, and the value is on the right side of the equal sign.

   Note that Google inserted a plus sign (+) between the words Cisco and Systems in the request string. You do not need to include that character in the HTTP Request Data dialog box. Desktop Work Flow Administrator will add an acceptable string to indicate the space between the words.

2. After you have entered the request data, click Preview to view the resulting request string.

   It should be identical to the string displayed in the Google search results address bar. If you used a plus sign between the words Cisco and Systems, you will see “%2B” instead of the plus sign; if you used a space, you will see “%20”. These strings indicate a space and are an acceptable substitute for the plus sign.
3. Click Test to test your HTTP request.
   The request should open your browser, navigate to the Google Search page, and run a search for Cisco Systems.

IPC Action

This action is available to Agent Desktop agents at the Premium level.

IPC actions pass information in the form of UDP (user datagram protocol) messages from the agent desktop to a third-party application using IPC (interprocess communication) methods. The third-party application can be located on the agent’s PC or anywhere on the network.

**NOTE:** You must have a custom application written that listens for data sent to a specific IP address and port.

An IPC action is one-way—that is, when CAD sends data using an IPC action, it does not receive a response or any acknowledgement that the message was received by the recipient third-party application.

The data sent is enterprise data or user-defined data. It is sent in the format:

```
valuename=value&name=value&name=value...
```

To set up an IPC action:

1. Set up a new action. See “Adding a New Action” on page 98.
   The Select Action window appears.

2. Select the IPC Action tab, and then click New.
The IPC Action Setup dialog box appears (Figure 58).

Figure 58. IPC Action Setup dialog box

3. Complete the IPC Action Setup dialog box as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Name</td>
<td>Enter a name for the new action.</td>
</tr>
<tr>
<td>Protocol</td>
<td>The default (and only) protocol is UDP.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Enter the IP address of the third-party application that will receive the data.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port number the third-party application is listening on for data.</td>
</tr>
</tbody>
</table>

4. Click Add to display the IPC Request Data dialog box (Figure 59).
The fields added with this dialog box make up the query portion of the request.

Figure 59. IPC Request Data dialog box

5. Complete the IPC Request Data dialog box as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Name</td>
<td>Enter the name of the field.</td>
</tr>
<tr>
<td>Value Type</td>
<td>Select DataField to use an enterprise data variable as the source of the data. Select UserDefined to use a specific string entered in the Value field.</td>
</tr>
<tr>
<td>Value</td>
<td>If you selected a value type of DataField, select the enterprise data variable from the drop-down list. If you selected UserDefined, enter the value to be used.</td>
</tr>
</tbody>
</table>

6. Continue to build your request using the Add, Edit, and Delete buttons as needed.

7. When you have completed building the request, click OK.

**Launch External Application Action**

Launch External Application actions start a third-party application in a new window.

To ensure applications are running before macros attempt to use them, start them with launch actions assigned to the Startup event.
NOTE: An application started by a launch action must use the same path on the agent’s PC as it does on the administrator’s PC or it must be on a network drive, or the launch action will not be successful.

When using launch actions, Agent Desktop can pass parameters such as command line arguments in two ways.

The first method is to add parameters after the application path name. For example, the command to start Microsoft Excel and open a spreadsheet named mrmtest.xls is:

“c:\program files\excel.exe” “c:\my documents\mrmtest.xls”

NOTE: Program names and command line arguments that contain spaces must be in quotes so that they appear as one argument rather than as multiple arguments.

The second method involves passing data fields as arguments. You can pass any valid data field while launching an application. Note that if a launch action takes place on the Startup event, call data might not be present. Empty or blank data fields will contain the string <NULL>.

To set up a Launch External Application action:

1. Set up a new action. See “Adding a New Action” on page 98. The Select Action window appears.
2. Select the Launch External Application Action tab, and then click New. The Launching External Application Action Setup dialog box appears (Figure 60).

![Figure 60. Launching External Application Action Setup dialog box](image)

3. Enter a name for the action and enter the path to the desired application's location. Make sure the application is located so that it is available to Agent Desktop at runtime.

4. Add any arguments you want to pass to the application. Choose the desired argument in the Available Arguments list, and use the left arrow to add it to the Argument list. Use the up and down arrows to reorder the Argument list.

5. When you have finished entering information, click OK.

**Run Macro Action**

A macro is a shortcut for a sequence of keystrokes. For example, you might record a macro that performs the following tasks with each incoming call:

1. Copy the ANI (Automatic Number Identification) from Agent Desktop to Microsoft Outlook
2. Open a contact list
3. Find the ANI in a database or spreadsheet
4. Display a screen containing the caller’s account information

**NOTE:** Do not use a Run Macro action to perform tasks that can be accomplished by one of the other types of actions available. For
example, use a Call Control action to transfer a call, and an Agent State action to change agent states.

**NOTE:** Run Macro actions do not work correctly when Chinese and Korean characters (and potentially any multi-byte characters) are used.

**Macro Recording Tips**

If your macro accesses a third-party application, make sure that the application is open. If the macro enters text into the third-party application, make sure that application has Windows focus.

Keystroke macros play back to the top level window they were recorded in. If you are running a keystroke macro to a Terminal Services window, you must make sure that the appropriate application in that Terminal Services window always has focus, otherwise the keystrokes will be sent to the wrong application.

Before you begin to record the macro, make a test run with the third-party application, writing down all of the keystrokes required for the tasks you want to perform.

Avoid using:

- Tab or arrow keys in your macro because the cursor can not always be in the same position each time a window opens.
- Mouse clicks and movements, because the macro recorder does not record them.

Use keyboard shortcut keys instead to perform actions in the application.

**NOTE:** When a macro is executed, it can be impacted by the current keyboard settings of the client PC. Care should be taken to ensure that keyboard settings, such as Caps Lock, are not inadvertently left on. Agents should also be cautioned not to enter keystrokes while a macro is running, since that can also affect the macro.

Shortcut keys are indicated by an underlined letter in the button name, field name, or description. You press Alt, Ctrl, or Shift plus the underlined letter to perform the action. For instance:

![Edit button]

In this case, pressing Alt+E clicks the Edit button.
The exact keystrokes for a keyboard shortcut are listed in the application’s menu. For instance, in Microsoft Word, to find out what the shortcut is to save a document, choose File from the menu bar. On the drop-down menu the Save option is followed by its shortcut, Ctrl+S.

Common Windows shortcut keys are:

<table>
<thead>
<tr>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc</td>
<td>Cancels an action.</td>
</tr>
<tr>
<td>Enter</td>
<td>Clicks OK or the default button in a dialog box. (Default buttons have a heavier border surrounding them.)</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Selects all text.</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copies selected text to the clipboard.</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Prints the document.</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Saves the document.</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Pastes text into the window at the cursor position.</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cuts selected text to the clipboard.</td>
</tr>
</tbody>
</table>

A macro can include keystrokes for multiple applications. For example, one macro might include keystrokes for word processing, spreadsheet, and database applications.

To switch between applications when recording a macro, use the mouse to select the application. Do not press Alt-Tab. If you do, these keystrokes are recorded and might not select the correct application when you play back the macro.

**NOTE:** Do not press Ctrl+Esc to click the Microsoft Windows Start button, or the Macro Recorder stops recording without providing a message showing that recording has stopped. All keystrokes recorded up to this point are deleted. To click Start without causing an error or stopping recording, use your mouse.
## Allowed Macro Keystrokes

Table 15.  Allowed Macro Keystrokes—Keys

<table>
<thead>
<tr>
<th>Key Type</th>
<th>Key</th>
<th>Macro Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character</td>
<td>0 1 2 3 4 5 6 7 8 9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A B C D E F G H I J K L M N O P Q R S T U V W X Y Z</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* + ; = , ./ [ ] '</td>
<td></td>
</tr>
<tr>
<td>Non-Character</td>
<td>Tab</td>
<td>[TAB]</td>
</tr>
<tr>
<td></td>
<td>Backspace</td>
<td>[BACKSPACE]</td>
</tr>
<tr>
<td></td>
<td>Enter/Return</td>
<td>[ENTER]</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>[SHIFT]</td>
</tr>
<tr>
<td></td>
<td>Control/Ctrl</td>
<td>[CONTROL]</td>
</tr>
<tr>
<td></td>
<td>Alt</td>
<td>[ALT]</td>
</tr>
<tr>
<td></td>
<td>Pause/Break</td>
<td>[PAUSE]</td>
</tr>
<tr>
<td></td>
<td>Caps Lock</td>
<td>[CAPSLOCK]</td>
</tr>
<tr>
<td></td>
<td>Esc</td>
<td>[ESC]</td>
</tr>
<tr>
<td></td>
<td>Space/Space Bar</td>
<td>[SPACE]</td>
</tr>
<tr>
<td></td>
<td>Page Up/PgUp</td>
<td>[PAGE-UP]</td>
</tr>
<tr>
<td></td>
<td>Page Down/PgDn</td>
<td>[PAGE-DOWN]</td>
</tr>
<tr>
<td></td>
<td>End</td>
<td>[END]</td>
</tr>
<tr>
<td></td>
<td>Home</td>
<td>[HOME]</td>
</tr>
<tr>
<td></td>
<td>Left Arrow</td>
<td>[LEFT-ARROW]</td>
</tr>
<tr>
<td></td>
<td>Up Arrow</td>
<td>[UP-ARROW]</td>
</tr>
<tr>
<td></td>
<td>Right Arrow</td>
<td>[RIGHT-ARROW]</td>
</tr>
<tr>
<td></td>
<td>Down Arrow</td>
<td>[DOWN-ARROW]</td>
</tr>
<tr>
<td></td>
<td>Print Scrn</td>
<td>[PRINTSCREEN]</td>
</tr>
<tr>
<td></td>
<td>Insert</td>
<td>[INSERT]</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>[DELETE]</td>
</tr>
<tr>
<td></td>
<td>F1 through F24</td>
<td>[F1] ... [F24]</td>
</tr>
</tbody>
</table>
Follow these steps to record a macro.

**To record a macro:**

1. Start any third-party applications you want to include in the new macro, and then minimize them.
2. Set up a new action. See “Adding a New Action” on page 98. The Select Action window appears.
3. Select the Run Macro tab, and then click New. The New Macro dialog box appears.

### Table 16. Allowed Macro Special Commands

<table>
<thead>
<tr>
<th>Special Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ENTERPRISE FIELD:]</td>
<td>Inserts an Enterprise Data field.</td>
</tr>
<tr>
<td>[DATA FIELD:]</td>
<td>Inserts data from Agent Desktop.</td>
</tr>
<tr>
<td>[SYSTEM FIELD:]</td>
<td>Inserts data from Agent Desktop system fields.</td>
</tr>
<tr>
<td>[APPLICATION:=]</td>
<td>Changes focus to an application window. The equal sign ( = ) is used as a separator between the application and the window title. If either the application name or window title is missing, Agent Desktop attempts to find the correct application and window to play the macro to, based on the parameters present.</td>
</tr>
<tr>
<td>[DELAY]</td>
<td>Time, in milliseconds, to wait before performing the next macro command. Example: [DELAY] 1000 delays the next macro key or command by 1 second.</td>
</tr>
</tbody>
</table>
4. Enter a new macro action name, and then click OK. The Macro Editor window appears (Figure 61).

Figure 61. Macro Editor window with a macro script displayed

5. Click Record. The Macro Editor window minimizes and the macro recorder starts. Anything you type from now on is entered in the new macro.

6. Maximize the third-party application and begin typing. The macro recorder records your keystrokes.
7. If you want to insert an Agent Desktop or CAD-BE data field into the macro, press the Pause Macro hot key (the default is F2). The Macro Recorder Suspended dialog box appears (Figure 62).

**Figure 62. Macro Recorder Suspended dialog box**

![Macro Recorder Suspended dialog box](image)

**NOTE:** Do not change the window focus away from the third-party application to the macro recorder before pressing the Pause Macro hot key and inserting a data field. If you do this, you will receive an error message and your macro recording will be interrupted.
8. Click Insert Data. The Select a Data Field dialog box appears (Figure 63). See “Data Fields” on page 129 for more information.

9. Choose the desired data field from the list, enter test data if desired, and then click OK. The test data you enter is displayed in the application only when the macro is tested using the Playback function.

   The Macro Recording Suspended dialog box appears.

10. Click Resume Recording to continue recording the macro.

11. Once you have finished recording the macro, press the macro hot key. The Macro Recording Suspended dialog box appears.

12. Click End Recording. You are returned to the Macro Editor window.

13. You can take any of the following actions:

   ■ Click OK to save the macro as recorded.
      
      If there are no errors, the macro is saved and you are returned to the Select Action dialog box.
      
      If there are errors, the macro editor displays the line and highlights the text in question. Correct it and click OK again.

   ■ Click Playback to test the macro.
      
      If there are errors, the macro editor displays the line and highlights the text in question. Correct it and click Playback again.
If there are no errors, the macro is played back. If it works as you want it to, click OK to save it and return to the Select Action dialog box.

To change test data, choose Data > Change Test Data in the macro editor and enter new test data.

- Click Cancel to cancel the macro.

The macro is canceled and the Select Action dialog box appears.

**Data Fields**

The Select a Data Field dialog box (Figure 63) enables you to select and insert a Agent Desktop data field into a macro. Access this dialog box either through the Suspend Macro Recording dialog box or from the Data menu in the Macro Editor window.

There are three types of data fields:

- Standard. Data from the switch.
- System. System data, for example the date and time. These fields are enclosed in square brackets \[\].
- Enterprise. Data from the Enterprise service. These fields are marked with an asterisk (*).

**NOTE:** When selecting data fields to be used in actions or rules, keep in mind that not every data field is available for every event. For example, the calling number is not available during the Startup event. If an unavailable field is used, <N/A> is displayed in the application the macro pops.

These fields can be included in the Run Macro and Launch External Application work flow actions.

**Table 17** lists the available data fields.

**Table 17. Enterprise Data Fields**

<table>
<thead>
<tr>
<th>Data Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Account Number</td>
<td>The customer’s account number.</td>
</tr>
<tr>
<td>*Alerting Number</td>
<td>The number of the ringing device.</td>
</tr>
<tr>
<td>*ANI</td>
<td>The number of the phone that made a call.</td>
</tr>
<tr>
<td>*Application Data</td>
<td>The ISDN user-to-user information element.</td>
</tr>
<tr>
<td>*BAAccountNumber</td>
<td>Outbound Dialer: The customer’s account number.</td>
</tr>
<tr>
<td>*BABuddyName</td>
<td>Outbound Dialer: The customer’s first and last name separated by a comma.</td>
</tr>
</tbody>
</table>
### Table 17. Enterprise Data Fields — Continued

<table>
<thead>
<tr>
<th>Data Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*BACampaign</td>
<td>Outbound Dialer: The name of the campaign to which the call belongs.</td>
</tr>
<tr>
<td>*BADialedListID</td>
<td>Outbound Dialer: Unique key identifying a specific customer record within the Dialing_List table located in the BA private database.</td>
</tr>
<tr>
<td>*BAResponse</td>
<td>Outbound Dialer: Multi-purpose placeholder that sends data from Agent Desktop to the BA Dialer. This variable responds to the reservation call, schedule and cancel callbacks, and changes to the callback phone number.</td>
</tr>
<tr>
<td>*BAStatus</td>
<td>Outbound Dialer: Two characters indicating the mode and direction of the BA Dialer-initiated call. The first character identifies the call mode:</td>
</tr>
<tr>
<td></td>
<td>• P: Reservation call, Preview mode</td>
</tr>
<tr>
<td></td>
<td>• C: Customer call</td>
</tr>
<tr>
<td></td>
<td>• A: Reservation call, callback</td>
</tr>
<tr>
<td></td>
<td>• Z: Agent-to-agent transfer or conference customer call</td>
</tr>
<tr>
<td></td>
<td>During a reservation call, the first character is P or A. When a customer call is transferred to an agent, the first character is C.</td>
</tr>
<tr>
<td></td>
<td>The second character of BAStatus indicates the call direction:</td>
</tr>
<tr>
<td></td>
<td>• O: Outbound</td>
</tr>
<tr>
<td></td>
<td>• I: Inbound</td>
</tr>
<tr>
<td></td>
<td>• B: Blended</td>
</tr>
</tbody>
</table>
Table 17. Enterprise Data Fields — *Continued*

<table>
<thead>
<tr>
<th>Data Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| *BATimeZone                  | Outbound Dialer: Indicates the GMT offset, in minutes, for the customer’s time zone and obtains the customer’s local time. The format of this ECC variable is +/–#####. This field’s first character is either a positive or negative sign, followed by 5 digits. For example:  
  • This example indicates that the customer is one hour behind GMT:  
    BATimeZone = -00060  
  • This example indicates that the customer is two hours ahead of GMT:  
    BATimeZone = +00120 |
| *Call Duration               | The difference between the call’s end time and start time. The time is read from the Enterprise server’s clock.                                 |
| *Collected Digits            | Digits entered by the caller in response to IVR prompting.                                                                                   |
| *DNIS                        | The number of the phone that received a call.                                                                                                 |
| *ICM Call Variable 1…        | Call-related variable data. There are 10 available variables.                                                                                   |
| *ICM Call Variable 10        |                                                                                                                                             |
| *Last Called Number          | The last number dialed.                                                                                                                      |
| *Last Calling Number         | The last device that made a call.                                                                                                             |
| *Last Connected Number       | The last monitored device that joined the call.                                                                                               |
| *Last Queued Time            | The amount of time spent in queue the last time the call was queued. The time is read from the Enterprise server’s clock.                    |
| *Last Redirection Number     | The last number the call was redirected from.                                                                                                 |
| *Layout                      | The name of the enterprise data layout.                                                                                                       |
**Set Enterprise Data Action**

This action enables you to set one enterprise data field variable that appears in the Agent Desktop or CAD-BE enterprise data pane to a desktop variable or static text of your choosing.

The action is available only for the Ringing and Answered events.

**NOTE:** Do not include a Set Enterprise Data action in the same work flow as the following Call Control actions: blind transfer, single-step transfer, supervised transfer, blind conference, single-step conference or supervised conference. This can cause a critical race condition that results in the enterprise data not being available.
To set up a Set Enterprise Data action:

1. Set up a new action. See “Adding a New Action” on page 98. The Select Action window appears.

2. Select the Set Enterprise Data tab, and then click New. The Set Enterprise Data Action Setup Editor dialog box appears (Figure 64).

Figure 64. Set Enterprise Data Action Editor dialog box

3. Complete the dialog box as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Name</td>
<td>Enter a name for the new action.</td>
</tr>
<tr>
<td>Enterprise Data Field to Set</td>
<td>Select the enterprise data field you whose content you want to set. You can choose from among ECC, call, and BA (Cisco Outbound Dialer) variables.</td>
</tr>
<tr>
<td>Select one of the following data sources:</td>
<td></td>
</tr>
<tr>
<td>Desktop Variable</td>
<td>From the drop-down list, select the desktop variable you want to be entered automatically in the enterprise data field. Your choices are Agent ID, System Name, System Time, or Skill Group.</td>
</tr>
<tr>
<td>Static Text</td>
<td>Enter the static text you want to be entered automatically in the enterprise data field. Maximum length of text for ECC fields is 210 characters, and for call variables, 39 characters.</td>
</tr>
</tbody>
</table>

4. Click OK.
Timer Action

This action is available to Agent Desktop and CAD-BE agents at the Enhanced and Premium levels.

The timer action enables you to trigger Agent State, HTTP, Agent Notification or Set Enterprise Data actions after a certain amount of time has elapsed under specified circumstances.

For instance, you can configure the Timer action to change the agent’s state to Ready if the agent has been in the Work state for 3 minutes.

To set up a Timer action:

1. Set up a new action. See “Adding a New Action” on page 98. The Select Action window appears.

2. Select the Timer Action tab, and then click New. The Timer Action Setup dialog box appears (Figure 65).

Figure 65. Timer Action Setup dialog box

3. Complete the Timer Action Setup dialog box as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Name</td>
<td>Enter a name for the new action.</td>
</tr>
</tbody>
</table>
4. Click Add to select or set up the actions you want to execute when the timer has expired. You can choose among the following types of actions:

- Agent Notification Action (page 103)
- Agent State Action (page 105)
- HTTP Action (page 109)
- Set Enterprise Data Action (page 132)

5. When you have configured the Timer Expiration Work Flow, click OK.

Utility Action

There are three utility actions:

- Start recording
- Stop recording
- Send a predefined, high-priority chat message to the agent’s supervisor

High Priority Chat Messages

A high priority chat message is a predefined message that appears in a supervisor’s Chat window. The message behaves just like a regular chat message that is tagged as high priority—it pops up on the supervisor’s screen on top of all other windows to attract the supervisor’s attention.

You can configure a task button on the Agent Desktop or CAD-BE toolbar to send such a message from an agent to the agent’s supervisor(s).

NOTE: For CAD-BE agents, a high priority chat message can be sent but it cannot be replied to by the supervisor, because CAD-BE agents do not have chat capability.

To set up a utility action:

1. Set up a new action. See “Adding a New Action” on page 98. The Select Action window appears.
2. Select the Utility Action tab, and then click New. The Utility Action Setup dialog box appears (Figure 66).

Figure 66. Utility Action Setup dialog box

![Utility Action Setup dialog box]

3. Enter a name for the new action, select an action type from the drop-down list, and then click OK.
   - If you select Record as the action type, select Start or Stop from the Action field.
   - If you select HighPriorityChat, type the message you want to send as the predefined, high-priority chat message in the Message field.

**NOTE:** When the dialog box initially opens, only the Action Name and Action Type fields are visible. When you choose the Record action type, the Action field appears. When you choose the High Priority Message action type, the Message field appears.

**NOTE:** If a Record action is part of a voice contact work flow, the agent being recorded will see a recording icon in the contact appearance pane even if notification is turned off.

**NOTE:** When configuring a work flow that includes a recording action, you must consider the bandwidth and storage capacity of your system. For more information on recording bandwidth and storage requirements, see Cisco Unified Contact Center Express 8.5 Solution Reference Network Design (SRND), available at: http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_implementation_design_guides_list.html
Agent’s State Change Notification and Announcement

Agent Desktop can be configured so that agents who are vision-impaired are notified of agent state changes. This is accomplished by creating work flows that either pop agent notifications that can be read by a screen reader, or that launch an appropriate recorded message that is played through the agent’s computer speakers.

The type of work flow you create depends on which agent state change you want to announce.

■ Use a voice contact work flow to announce transition to the Work state.
■ Use an agent management work flow to announce transition to the Ready and Not Ready state.

Use either of the following actions with the work flow.

■ Agent Notification action. A custom message is popped on the agent’s desktop when the agent changes agent state. This notification can then be read by a screen reader.
■ Launch External Application action. A sound file is played when the agent changes agent state.

To announce the agent state changes verbally using the Agent Notification action:

1. Create a new Agent Notification action (See “Agent Notification Action” on page 103).
2. When configuring the action, complete the Agent Notification dialog box with a relevant custom message as shown in the example in Figure 67.

Figure 67. Agent Notification Action Setup dialog box

3. Associate the new action with a work flow so that it is launched when the agent state changes. For example, if you are configuring the Work event in the Voice Contact Work Flows node, apply an agent notification action as shown in
4. Click Apply. The change goes into effect when the agent restarts Agent Desktop.

To announce agent state changes verbally using the Launch External Application action:


2. When configuring the action, complete the Launch External Application dialog box as shown in the example in Figure 69. To play a WAV file, enter the path of the pre-recorded sound file. For example, the command to open a WAV file named Not_Ready.wav is:

   “D:\Recorded Files\State Changes\Not_Ready.wav”
To play a sound file other than WAV file, enter the path of a sound player application that is available on the agent desktop, and append the argument with the path of the pre-recorded sound file. The format of the sound file should be supported by the sound player application that you want to launch.

Figure 69. Launching External Application Action Setup dialog box

3. Associate the new action with a work flow so that it is launched when the agent state changes. For example, if you are configuring the Not Ready event in the Agent Management Work Flows node, apply the external application
launching action as shown in Figure 70.

Figure 70. Launch External Application action on the Not ready event

4. Click Apply. The change goes into effect when the agent restarts Agent Desktop.
Cisco Unified CCX Outbound Preview Dialer

Cisco Unified Outbound Preview Dialer (Outbound Dialer) is a Unified CCX feature that enables automated outbound dialing to customers. These outbound calls appear as inbound calls to the agent, and information about the call appears in the Enterprise Data pane.

**NOTE:** Outbound Dialer is available only for Agent Desktop.

A supervisor or administrator sets up a calling campaign in Unified CCX that consists of various elements that will present calls to agents and provide information so the agent can handle the call successfully. (See the Cisco Unified CCX Administration Guide for information on setting up calling campaigns.)

Outbound Dialer uses the Direct Preview Dialing Mode. In this mode, an agent is reserved and then presented with a customer call along with customer information in the Enterprise Data window. Based on this information, the agent can decide to accept, skip, or reject the call. The agent can also categorize the phone call presented as Voice, Answering Machine, Invalid, or Fax Modem.

The customer callback feature enables an agent to reschedule a customer call at the customer’s request for a more convenient time. When the call is redialed, the call is directed to any available agent.

**Outbound Dialer Actions**

Based on the enterprise data information, the agent selects the appropriate Outbound Dialer action button on the Outbound Dialer toolbar.

The available Outbound Dialer actions and their associated toolbar buttons are displayed in Table 18.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Accept" /></td>
<td>Accept</td>
<td>The system dials the customer and connects the call to the agent.</td>
</tr>
<tr>
<td><img src="image" alt="Reject" /></td>
<td>Reject</td>
<td>The system rejects the current call and releases the agent from the outbound calling reservation. At this point, the system might deliver to the agent another outbound call or a new inbound call.</td>
</tr>
<tr>
<td><img src="image" alt="Reject Close" /></td>
<td>Reject Close</td>
<td>The system rejects the current call and closes the record so the customer will not be called again.</td>
</tr>
</tbody>
</table>
Outbound Dialer Toolbar

In order for the Outbound Dialer actions to be available for agents to use, you must configure the agent interface to include the Outbound Dialer toolbar.

NOTE: You cannot prevent an agent from receiving Outbound Dialer calls by removing the Outbound Dialer toolbar from the agent’s desktop. The agent must also be removed from the CSQ that is handling the Outbound Dialer calls.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip</td>
<td>The system skips the current call and presents the agent with another customer call.</td>
<td></td>
</tr>
<tr>
<td>Skip Close</td>
<td>The system skips the current call and closes the record so the customer will not be called again.</td>
<td></td>
</tr>
<tr>
<td>Skip-Next</td>
<td>The system skips the call and displays a menu of these options:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Wrong Number. The agent is informed that the number called is a wrong number. After the call terminates, the system calls other customer phone numbers.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Not Home. The agent is informed that the customer is not home. After the call terminates, the system calls other customer phone numbers.</td>
<td></td>
</tr>
<tr>
<td>Callback</td>
<td>Displays the Callback Properties dialog box, which the agent uses to set a time and date to call back the customer. The agent also uses this dialog box to cancel a previously-scheduled callback of the current customer. This action works only if the call has been connected to the customer and if the agent is in a talking or wrap-up state during a Unified CCX-generated call.</td>
<td></td>
</tr>
<tr>
<td>Reclassify</td>
<td>Displays a menu that enables the agent to reclassify a customer phone number as voice, answering machine, fax/modem, or an invalid number.</td>
<td></td>
</tr>
<tr>
<td>Cancel Reservation</td>
<td>The system releases the agent from the calling campaign and places the agent in the Not Ready state. To resume participating in the calling campaign, the agent must change the agent state to Ready.</td>
<td></td>
</tr>
</tbody>
</table>
To configure the Outbound Dialer toolbar to appear:

1. In the User Interface window, select the Toolbar tab.

2. In the Outbound Dialer Mode section, select the Direct Preview check box (Figure 71).

   The appropriate buttons are enabled in the button selection pane.

   **NOTE:** Instead of selecting the Direct Preview check box and enabling all Outbound Dialer buttons, you can configure selected Outbound Dialer toolbar buttons to appear on the Agent Desktop interface. See “Adding and Removing Toolbar Buttons” on page 65 for more information.

   **NOTE:** The Accept and Cancel Reservation buttons are required for CAD to function with Outbound Dialer and must not be disabled. If you disable them, an error message (System Error. To correct this problem please see your administrator.) will be displayed.

3. Click Apply to save your changes.

   The Outbound Dialer toolbar will now appear on the Agent Desktop interface.

Figure 71. User Interface toolbar tab
Outbound Dialer Enterprise Data

Whenever an agent receives an Outbound Dialer call, the agent will see Outbound Dialer enterprise data. Unified CCX automatically uses the Outbound Dialer enterprise data layout (OODefault), which contains all the Outbound Dialer enterprise data variables, instead of the regular default layout.

The Outbound Dialer enterprise data variables are listed in Table 19.

Table 19. Cisco Outbound Dialer enterprise data variables.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAAccountNumber [200]</td>
<td></td>
</tr>
<tr>
<td>BABuddyName [201]</td>
<td></td>
</tr>
<tr>
<td>BACampaign [202]</td>
<td></td>
</tr>
<tr>
<td>BADialedListID [203]</td>
<td>Required in order for the Skip function to work</td>
</tr>
<tr>
<td>BAResponse [204]</td>
<td></td>
</tr>
<tr>
<td>BASTatus [205]</td>
<td>Required for all dialing modes.</td>
</tr>
<tr>
<td>BATimeZone [206]</td>
<td>Required for all dialing modes in order for the Callback function to work.</td>
</tr>
<tr>
<td>BACustomerNumber [207]</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** If a call is part of a Direct Preview dialing mode campaign, the first letter in the BASTatus field entry is a D when the dialer puts the agent in the reserved state, and a C when the agent is connected to a customer. If the BASTatus field is blank, all Outbound Dialer buttons are disabled. This might be the result of a communication or configuration problem.

You can edit the OODefault layout if you want to change which variables are displayed. For instructions on editing layouts, see “Creating a Custom Layout” on page 155.
Getting Started with Desktop Administrator

Introduction

Desktop Administrator enables you to configure the following CAD elements:

- **Services Configuration**—enterprise data, multi-line calls, monitoring and recording, and synchronize directory services
- **Personnel**—agents
- **Cisco Unified Presence Settings**:
  - Cisco Unified Presence Cluster Settings
  - Contact Lists
  - External Contacts
  - Work Flow Groups
- **Agent E-Mail Settings**
  - Global Settings
  - Contact Service Queue Settings
  - Templates
- **CAD Configuration Setup**
Accessing Desktop Administrator

You can launch Desktop Administrator by one of these methods:

- Launching Desktop Work Flow Administrator
- Accessing the Cisco Desktop Administrator URL
- Accessing the Unified CCX Administration Authentication page to launch Desktop Administrator

The credentials for accessing Unified CCX Administration and launching Desktop Administrator are the same. This allows you to launch Desktop Administrator from the Unified CCX Administration Authentication page without logging in again.

**NOTE:** Only one person at a time can make changes in Desktop Administrator. Until a user logs out or until that user’s login times out after 15 minutes of inactivity, other users can only view information.

**To launch Desktop Administrator from Desktop Work Flow Administrator:**

1. From the Desktop Work Flow Administrator menu bar, choose Desktop Administrator > Side A. If your system includes redundancy, you can also choose Side B.
   The https://<CCX-server>/teamadmin/main.cda URL opens in the web browser and launches Desktop Administrator.

2. Enter your Unified CCX username and password, and then click Login. The Cisco Desktop Administrator home page appears.

**To launch Desktop Administrator by accessing the Desktop Administrator URL:**

1. In the web browser, enter https://<CCX-server>/teamadmin/main.cda, where <CCX-server> is the hostname or IP address of the server that hosts Cisco Unified Contact Center Express.
   Desktop Administrator launches.

2. Enter your Unified CCX username and password, and then click Login. The Cisco Desktop Administrator home page appears.

**To launch Desktop Administrator from Unified CCX Administration:**

1. In the web browser, enter https://<CCX-server>/appadmin, where <CCX-server> is the hostname or IP address of the server that hosts Cisco Unified Contact Center Express.
   The Unified CCX Administration Authentication page appears.

2. Enter your Unified CCX username and password, and then click Login. The Cisco Unified CCX Administration home page appears.
3. Select Cisco Desktop Administrator from the Navigation drop-down list.
4. Click Go. The Cisco Desktop Administrator home page appears.
Using the Search Function

Follow these steps to search for one or more records on any Desktop Administrator page that contains the Search function.

**NOTE:** Searches are not case sensitive. For example, if you type a lowercase letter “s” in a search field, the results will include all items that begin with the lowercase letter “s” and the uppercase letter “S.”

To search for one or more records:

1. Enter your search criteria:
   - If you are searching for a text string, select the field name from the first drop-down list box, a search pattern from the second drop-down list box, and enter a text string in the third box.
   - If you are searching for a checked or cleared check box, select the check box name in the first drop-down list box, and True (checked) or False (cleared) in the second list box.

2. If necessary, complete any of the following actions.
   - If you want to add another criterion to the search query, click +. A new row appears. Repeat step 1 for the new row.
   - If you want to remove the last criterion from the search query, click —. The bottom row is deleted. If you click — and the search query only contains one criterion, no change occurs.
   - If you want to remove all of the criteria from the search query, click Clear Filter. All of the rows except the first row are deleted, and the first row is reset to the default value.

3. When you are done creating your search query, click Find. A list of results that match all of the criteria appears.
Introduction

You can perform the following tasks in the Services Configuration node:

- Configuring Enterprise Data (page 150)
- Configuring Display Settings (page 158)
- Configuring Desktop and Server Monitoring and Recording (page 161)
- Synchronizing Directory Services (page 166)
- Releasing the Desktop Administrator Lock (page 167)
Configuring Enterprise Data

The Enterprise Data node has two pages, the Fields page and the Layout List page.

You can perform the following tasks on the Fields page:

- Creating a Custom Field (page 151)
- Editing a Field (page 153)
- Deleting a Field (page 153)

You can perform the following tasks on the Layout List page:

- Creating a Custom Layout (page 155)
- Copying a Layout (page 156)
- Editing a Layout (page 157)
- Deleting a Layout (page 157)

Enterprise data is information associated with an incoming call. It is displayed in the Contact Management pane of Agent Desktop and CAD-BE, and on the Caller Data screen in IP Phone Agent.
Fields

Enterprise data fields and layouts are configured under the Enterprise Data node.

NOTE: The agent applications must be restarted for any enterprise data variable or layout changes you make to go into effect.

The Field List displays both the predefined fields available for your switch type and the custom fields you create.

- Predefined fields have index numbers of 159–255. Only the display name of these fields is editable, with the exception of field 252, whose display name and field name can be edited. Note that when you click the Select All button, these fields are not selected.
- Custom fields have index numbers of 0–158, and are editable.

Creating a Custom Field

To create a custom field:

1. Choose Services Configuration > Enterprise Data > Fields. The Field List page appears (Figure 72).

Figure 72. Field List page
2. Click Add New. The Add New page appears (Figure 73).

![Add New page](image)

3. Complete the fields as described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Name</td>
<td>The variable’s field name. The field name and value can be up to 29 characters long and can contain any character except:</td>
</tr>
<tr>
<td></td>
<td>- ` ~ ! @ # $ % ^ &amp; * ( ) - + = [ ] { &lt; &gt; , / ?</td>
</tr>
<tr>
<td></td>
<td>If you use disallowed characters in the field name or value, the enterprise data field might not display in the IP Phone Agent service.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The name that appears in desktop applications. The display name can be up to 29 characters long and can contain any character except:</td>
</tr>
<tr>
<td></td>
<td>- ` ~ ! @ # $ % ^ &amp; * ( ) - + = [ ] { &lt; &gt; , / ?</td>
</tr>
<tr>
<td>Expanded Call Context (ECC)</td>
<td>If the field is an ECC variable, select the appropriate check box:</td>
</tr>
<tr>
<td></td>
<td>• Scalar: A scalar ECC variable is one that stores a single piece of data.</td>
</tr>
<tr>
<td></td>
<td>• Array: An array ECC variable is one that stores multiple pieces of data.</td>
</tr>
<tr>
<td></td>
<td>If you selected array, choose the number of elements in the array from the number field drop-down list.</td>
</tr>
</tbody>
</table>
4. Click Save to save your changes. The field is added.
5. When you are finished adding fields, click Return to Field list.

Editing a Field

To edit a field:

1. Choose Services Configuration > Enterprise Data > Fields. The Field List page appears (Figure 72).
2. If necessary, search for the field you want to edit. For instructions, see "Using the Search Function" on page 148.
3. Select the field by clicking its name. The Field Information page for that field appears.
4. Edit the field information as desired.
   - For predefined fields, you can edit only the display name.
   - For custom fields, you can edit all field information.
   - If you are editing an array field, the field index numbers assigned to the array elements are listed, separated by commas.
5. When you are finished making changes, click Save, then click Return to Field list.

Deleting a Field

You cannot delete a predefined field. You can delete only custom fields.

If the field selected for deletion is the only field associated with a custom layout, you cannot delete it until another field is added to the custom layout, or the layout itself will be deleted. Either delete the custom layout, or add another field to it and then delete the field you originally intended to delete.

If the field selected for deletion is the only field associated with a default layout, you cannot delete it until another field is added to the default layout. Default layouts cannot be deleted, and must always contain at least one field.
To delete a custom field:

1. Choose Services Configuration > Enterprise Data > Fields. The Field List page appears (Figure 72).

2. If necessary, search for the field you want to delete. For instructions, see "Using the Search Function" on page 148.

3. Select the check box corresponding to one or more custom fields, then click Delete Selected. The selected fields are no longer displayed in the Field list. However, the actual deletion is not performed until you click Save.
The Layout List displays the field layouts available for use in the agent applications. Each layout can contain up to 16 fields chosen from the Field List.

There are two default layouts:

- default—basic layout for normal operations
- OODefault—layout for Cisco Outbound Dialer campaigns

Unified CCX automatically uses the default layout for normal call activity. If you want to use a custom layout, a custom script to pop that layout must be created.

You cannot delete the default layout, but it can be edited to add or remove enterprise data variables.

You can create up to 14 custom layouts in addition to the default layouts. Once the limit of custom layouts is reached, the Add New and Copy buttons are disabled.

Creating a Custom Layout

To create a custom layout:

1. Choose Services Configuration > Enterprise Data > Layouts. The Layout List page appears (Figure 74).

![Layout List page](image)
2. Click Add New. The Add New page appears (Figure 73).

Figure 75. Add New page

3. Complete the fields as described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout Name</td>
<td>The layout name must be unique and be no longer than 16 characters.</td>
</tr>
<tr>
<td>Available</td>
<td>The fields available to be used in the layout. The list shows</td>
</tr>
<tr>
<td></td>
<td>the field’s index number and display name.</td>
</tr>
<tr>
<td>Selected</td>
<td>The fields that have been selected to be in the layout. The list shows</td>
</tr>
<tr>
<td></td>
<td>the field’s index number and display name.</td>
</tr>
</tbody>
</table>

4. Use the arrow buttons to move selected fields between the Available and Selected panes. Use the double arrow buttons to move all fields from one pane to the other. Use the Up and Down buttons to change the order of the fields in the Selected pane.

5. Click Save to save the custom layout. The layout is added to the Layouts list page.

6. When you are finished adding custom layouts, click Return to Layout list.

Copying a Layout

1. Choose Services Configuration > Enterprise Data > Layouts. The Layout List page appears (Figure 74).
2. Select the layout you want to copy. The selected layout list page appears.
3. Click Copy.
4. Enter a name for the new layout and edit the fields as needed.
5. Click Save to save the copied layout. The layout is added to the Layouts list page.
6. If desired, repeat steps 4 and 5 to create more new layouts.
7. When you are finished, click Return to Layout list.

Editing a Layout

1. Choose Services Configuration > Enterprise Data > Layouts. The Layout List page appears (Figure 74).
2. Select the layout you want to edit. The selected layout list page appears.
3. Edit the layout as needed.
4. Click Save to save the edited layout.
5. When you are finished, click Return to Layout list.

Deleting a Layout

You cannot delete a default layout. You can delete only custom layouts.

To delete a custom layout:

1. Choose Services Configuration > Enterprise Data > Layouts. The Layout List page appears (Figure 74).
2. Select the check box corresponding to one or more custom layouts, then click Delete Selected. The selected layouts are no longer displayed in the Layout list. However, the actual deletion is not performed until you click Save.
Configuring Display Settings

You can perform the following tasks on the Display Settings page of the Multilne, Monitoring & Recording node:

- Enable non-ACD call display
- Configure monitoring and recording settings
- Enable agent notification messages for monitoring and recording

A call is defined as an ACD call if it meets one or more of the following criteria:

- The call is assigned to an agent from a voice CSQ
- At least one of the participants of the call is using an ACD line
- The call is transferred from an ACD line
- The call is conferenced with an ACD call to any other line

All other calls are considered as non-ACD calls by the system and appear in Agent Desktop and CAD-BE as per your configuration.

To configure Display Settings:

1. Choose Services Configuration > Multilne, Monitoring & Recording > Display Settings. The Display Settings page appears (Figure 76).

Figure 76. Display Settings page
2. Complete the fields as described below:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Multiline Calls</td>
<td></td>
</tr>
<tr>
<td>Display Non-ACD Calls</td>
<td>Select this check box to enable the display of non-ACD calls. If you enable the display of non-ACD calls, then both ACD and non-ACD calls appear in and can be controlled through Agent Desktop and CAD-BE. With multi-line settings enabled, an agent’s phone supports one ACD line and up to three non-ACD lines. Agents and supervisors can perform all general operations with the non-ACD calls (for example, answering, transferring, and conferencing). By default, non-ACD calls are not displayed. <strong>NOTE:</strong> The Display Non-ACD Calls check box must be selected to configure any other non-ACD call settings.</td>
</tr>
<tr>
<td>Monitoring &amp; Recording</td>
<td></td>
</tr>
<tr>
<td>Enable Supervisor Barge In/Intercept</td>
<td>Select this check box to enable supervisor to barge in and intercept agents’ ACD calls.</td>
</tr>
<tr>
<td>Non-ACD Calls</td>
<td>Select this check box to enable supervisor to barge in and intercept agents’ non-ACD calls.</td>
</tr>
</tbody>
</table>
3. Click Save to save the changes.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor/Record Non-ACD Calls</td>
<td>Select this check box to enable supervisor to monitor and record agents’ non-ACD calls. By default, supervisors can monitor or record agents’ ACD calls.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If you want to prevent a specific agent from being monitored and recorded, you must disable Desktop Monitoring and remove any assigned Monitor service from the agent’s extension on the VoIP Monitoring Device page. See &quot;Configuring Desktop and Server Monitoring and Recording&quot; on page 161 for more information. In this case, the supervisor receives appropriate error messages when attempting to monitor or record any agent call. However, Agent Desktop’s status bar will indicate “In Service” because monitoring and recording unavailability is not a result of any service failure.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable Notification Messages</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify Monitoring</td>
<td>Select this check box to enable agent notification for monitoring. If enabled, the agents get notification messages stating that the supervisor is monitoring their ACD calls (and if enabled, non-ACD calls).</td>
</tr>
<tr>
<td>Notify Recording</td>
<td>Select this check box to enable agent notification for recording. If enabled, the agents get notification messages stating that the supervisor is recording their ACD calls (and if enabled, non-ACD calls).</td>
</tr>
</tbody>
</table>
Configuring Desktop and Server Monitoring and Recording

You can perform the following tasks on the VoIP Monitoring Device page of the Multiline, Monitoring & Recording node:

- Enabling Desktop Monitoring (page 161)
- Configuring a Default Monitor Service (page 162)
- Assigning Phone Devices to a Specific VoIP Monitor Service (page 163)
- Removing a VoIP Monitor or Recording & Playback Service from Directory Services (page 163)

The VoIP Monitoring Device page displays all phone devices configured in Unified CM. If a phone is configured for extension mobility and a static extension is set up, the Extension field displays the static extension assigned to the device’s MAC address. If no static extension is set up, the Extension field is blank.

**NOTE:** Assign a static extension to an extension mobility device to make administration easier.

**Enabling Desktop Monitoring**

When desktop monitoring is enabled, software on the agent desktop handles recording and monitoring requests for that agent. This is possible only on desktops that are physically connected to the network through a hard IP phone or through a soft phone.

By default, desktop monitoring is enabled for all phone devices.

**NOTE:** Desktop monitoring does not function with some NIC cards that are unable to detect both voice packets and data packets in a multiple VLAN environment. For more information on this issue, and suggested work-arounds, see the *Cisco CAD Installation Guide*.

A phone is monitored either through desktop monitoring or a VoIP Monitor service—it cannot be monitored by both. However, a VoIP Monitor service can be a backup if the agent’s desktop monitoring module fails to register with Directory Services when Agent Desktop is started.
To enable desktop monitoring:

1. Choose Services Configuration > Multiline, Monitoring & Recording > VoIP Monitoring Device. The VoIP Monitoring Device page appears (Figure 77).

2. If necessary, search for the phone device for which you want to enable desktop monitoring. For instructions, see "Using the Search Function" on page 148.

3. From the Desktop Monitoring drop-down list, select Enable.

4. Click Save. Desktop monitoring is enabled for that device.

Configuring a Default Monitor Service

Select a default monitor service to avoid the possibility of having devices unassigned to any monitor service. This situation can arise when there is more than one VoIP Monitor service in the system.

**NOTE:** If your system has only one VoIP Monitor service, it is not necessary to set a default monitor service or to manually assign each device to that single monitor service. The VoIP Monitor service assumes that each device is assigned to it as the only available monitor service.

Modifications you make on the VoIP Monitoring Device page go into effect immediately after you save your changes.
To configure a default VoIP Monitor service:

1. Choose Services Configuration > multiline, Monitoring & Recording > VoIP Monitoring Device. The VoIP Monitoring Device page appears (Figure 77).
2. From the Default VoIP Monitor Service drop-down list, select the VoIP Monitor service you want to be the default service.
3. Click Save.

Assigning Phone Devices to a Specific VoIP Monitor Service

To assign a phone device to a specific VoIP Monitor service:

1. Choose Services Configuration > multiline, Monitoring & Recording > VoIP Monitoring Device. The VoIP Monitoring Device page appears (Figure 77).
2. If necessary, search for the phone device you want to assign to a VoIP Monitor server. For instructions, see "Using the Search Function" on page 148.
3. Select the Selected check box for the device, then select the desired VoIP Monitor service from the Monitor Service drop-down list.
   - To assign multiple devices, select the Selected check boxes for each device, then select the desired VoIP Monitor service from the drop-down list field above the list of devices, and then click Modify.
4. Click Save. The device or devices are now assigned to the specific VoIP Monitor service.

Removing a VoIP Monitor or Recording & Playback Service from Directory Services

The Remove VoIP/Recording/Playback Services page enables you to remove a VoIP Monitor service or Recording & Playback service from Directory Services and unregister it from the LRM service.

Remove these services only if you intend to uninstall (or already have uninstalled) the VoIP Monitor service or Recording & Playback service permanently. The Remove option enables you to clean up Directory Services.
To remove a VoIP Monitor or Recording & Playback service from Directory Services:

1. Choose Services Configuration > Multiline, Monitoring & Recording > Remove VoIP/Recording & Playback Services. The Remove VoIP/Recording & Playback Services page appears (Figure 78).

![Figure 78. Remove VoIP/Recording & Playback Services page](image)

2. From the appropriate drop-down list, select the service to be removed, and then click Remove. The service is removed from Directory Services.

When you remove a VoIP Monitor service from Directory Services, it also removes that service from the list of available VoIP Monitor services on the VoIP Monitoring Device page as well (Figure 77). This can result in devices becoming unmonitored.

If the selected VoIP Monitor service has been set as the default service, you are notified that this situation exists when you click Remove. When you click OK to confirm that you want to remove the default VoIP Monitor service, any device that was monitored by the default service will now be unmonitored. It is recommended that you select another VoIP Monitor service to be the default. See "Configuring a Default Monitor Service" on page 162 for more information.

If the VoIP Monitor service was selected to monitor specific devices, when you click OK the following can occur:

- The devices will be monitored by the default VoIP Monitor service (if one is configured)
- The devices will be monitored by desktop monitoring if Enable is selected in the Desktop Monitoring drop-down list for each device
- The devices will be unmonitored
If devices become unmonitored, search for them on the VoIP Monitor Devices page and reassign them to the default monitor, a specific monitor, or enable desktop monitoring.

To restore a removed service to Directory Services:

1. Start the removed service.
   - If you uninstalled the service, reinstall it. See the Cisco CAD Installation Guide for information on installing CAD services.
   - If you have not uninstalled the service, stop the service and then restart it, using the Windows Services utility in Control Panel.

2. In Desktop Administrator, click the VoIP Monitoring Device node again. The refreshed page shows that the service is restored to the list of available services.
Synchronizing Directory Services

The Directory Services database should be synchronized with the master Unified CCX agent database. The databases are synced automatically whenever the master Unified CCX database changes. However, you can manually sync them with the Synchronize Directory Services command.

**NOTE:** You can also synchronize Directory Services manually from Work Flow Administrator. See "Synchronizing Directory Services" on page 26 for more information.

**To synchronize the databases manually:**

1. Choose Services Configuration > Synchronize Directory Services. The Synchronize Directory Services page appears (Figure 79).

![Figure 79. Synchronize Directory Services page](image)

2. Click Synchronize. The databases are synchronized, and you will see the message, “Transaction successful” when the process is complete.
Releasing the Desktop Administrator Lock

Use the Force-release CDA Lock page to forcibly unlock Desktop Administrator in the event it remains locked even though no one is currently using it. This can occur if a user closes the browser without logging out of Desktop Administrator, and the lock does not automatically release after 15 minutes of inactivity.

It is recommended that you do not use the force-release option to lock out another user. However, if this happens, the other user will be able to save anything currently being modified. After the user has clicked Save, he or she will be locked out and will be unable to make any more modifications until you have logged out.

To forcibly unlock Desktop Administrator:

1. Choose System Configuration > Force-Release CDA Lock. The Force-Release CDA Lock page appears (Figure 80).

2. Click Release Lock. The lock on the application is released and you can now view and modify data.

NOTE: In a High Availability system, you must be logged in to the side on which Desktop Administrator was locked. If Desktop Administrator was locked by someone who logged in on Side A, you cannot unlock it if you are logged in on Side B.
Personnel Configuration

Introduction

Personnel displays a list of agents configured in Unified CCX. This node enables you to view information about agents and assign agent to work flow groups.
Configuring Agents

You can perform the following tasks from the Agents page of the Personnel node:

- Changing an Agent’s Work Flow Group (page 170)

Changing an Agent’s Work Flow Group

1. Choose Personnel > Agents. The Agents List page appears (Figure 81).

2. If necessary, search for the agent you want to assign to a work flow group. For instructions, see "Using the Search Function" on page 148.

3. Select the Selected check box for the agent, then select the desired work flow group from the Work Flow Group drop-down list field.

   To assign multiple agents to a work flow group, select the Selected check boxes for each agent, then select the desired work flow group from the drop-down list field above the list of agents, and then click Modify.

4. Click Save. The agent or agents are now assigned to the specific work flow group.
NOTE: If a recently-added work flow group does not appear in the drop-down list, or a recently-deleted work flow group does appear in the drop-down list, refresh the page by clicking the Personnel > Agents link again.

NOTE: If an agent’s team assignment is changed, the change does not go into effect until the CAD desktop applications are restarted.
Introduction

The Cisco Unified Presence Settings node in Desktop Administrator gives administrators the ability to integrate Cisco Unified Presence with CAD.

Integrating Unified Presence with CAD makes it possible for supervisors using Supervisor Desktop and agents using Agent Desktop to view the availability of non-agents using Cisco Unified Personal Communicator or Microsoft Office Communications Server (MOCS). This feature enables supervisors and agents to initiate chat sessions with subject matter experts (SMEs) who can provide information that can help agents assist customers more quickly and effectively.

For more information about Desktop Presence Administrator, see the description at the following URL:


Integrating a Unified Presence cluster with CAD consists of the following tasks.

- Configuring the Cisco Unified Presence Server (page 174)
- Configuring Contact Lists (page 178)
- Configuring External Contacts (page 187)
- Configuring Work Flow Groups (page 192)
- Configuring Supervisor Chat and Team Messages (page 196)
Configuring the Cisco Unified Presence Server

Several settings (an inbound access control list and the CAD client type) must be configured in the Unified Presence server in order for CAD agents to log in.

For more detailed information on configuring the Unified Presence server, consult the Cisco Unified Presence documentation available on www.cisco.com.

Configuring an Inbound Access Control List

The Cisco Unified Presence server must be configured to accept inbound requests from agent devices so that, when an agent logs into Cisco Agent Desktop, the agent’s computer will be able to connect to the Unified Presence server.

To enable this connection, an inbound Access Control List (ACL) must be configured to allow inbound messages from the agent computer’s IP address or to allow all inbound messages.

To configure the inbound ACL:

1. In Cisco Unified Presence Administration, navigate to System > Security > Incoming ACL.
2. Create an incoming ACL with the address pattern set to either the agent PC’s IP address or to ALL.

Configuring the CAD Client Type

This setting must be configured only if your system uses Unified Presence version 8.6 or newer. In order for CAD agents to be able to log into Unified Presence, the CAD client type must be added to Unified Presence Administration.

To add the CAD client type:

1. In Cisco Unified Presence Administration, navigate to Application > Client Types.
2. Click Add New.
3. Complete the Client Type page as follows:
   - Type: CAD
   - Description: CAD
   - Minimum Version: 0.0.0.0
   - Group: Standard CCM End Users
4. You must clear the Version Check Required checkbox.
5. Click Save.

6. You must restart the Cisco UP Client Profile Agent services (in Network Services).
Configuring the Cisco Unified Presence Cluster

The first task in integrating CAD with a Unified Presence cluster is configuring the Unified Presence cluster by specifying the connection information.

**NOTE:** It is assumed that all of the agents are managed in one Unified Presence cluster.

**NOTE:** All agents must be licensed as CUP Enabled and CUPC Enabled in Cisco Unified CM Administration in order to use Unified Presence from within Agent Desktop. An agent’s status can be verified by logging into Unified CM Administration and viewing System > Licensing > Capabilities Assignments. See the Unified CM Administration documentation for more information.

**To configure the Unified Presence cluster:**

1. Choose Cisco Unified Presence Settings > Cisco Unified Presence Cluster Settings. The Cisco Unified Presence Cluster Settings page appears (Figure 82).

![Figure 82. Cisco Unified Presence Cluster Settings page](image)

2. Complete the fields as described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Cisco Unified Presence Integration</td>
<td>Status of communication between supervisors and agents and non-agents.</td>
</tr>
</tbody>
</table>
3. Click Verify to confirm that the information you entered is correct. Desktop Presence Administrator connects to the Unified Presence server using the hostname or IP address, login ID, and password you entered.

4. Click Save to save your changes.

If you make changes to Service Profile settings in Cisco Unified CM Administration or LDAP related settings in Cisco Unified CM IM and Presence Administration, then you must re-establish the connection between CAD and the CUP server in Desktop Administrator to refresh these settings.

To re-establish the connection between CAD and the CUP server:

1. Choose Cisco Unified Presence Settings > Cisco Unified Presence Cluster Settings. The Cisco Unified Presence Cluster Settings page appears (Figure 82).
2. Clear the Enable Cisco Unified Presence Integration check box and click Save.
3. Re-select the Enable Cisco Unified Presence Integration check box and click Save again.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher Host/IP Address</td>
<td>Hostname or IP address of Unified Presence server (the publisher if you have a Unified Presence cluster).</td>
</tr>
<tr>
<td>Presence User Login ID</td>
<td>The Unified Communicator user ID of a user who can log in to Unified Communicator and who appears in the same LDAP or Active Directory as the contact center agents. This login ID should not be a Unified Presence administrator login ID.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the Presence User Login ID user.</td>
</tr>
<tr>
<td>Subscriber Host/IP</td>
<td>If you have a Unified Presence cluster, the hostname or IP address of the Unified Presence subscriber(s).</td>
</tr>
<tr>
<td>Addresses</td>
<td></td>
</tr>
</tbody>
</table>
Configuring Contact Lists

A contact list consists of the SMEs that you want to make available to agents who use Agent Desktop. Agents and supervisors see the SMEs in the Contact Selection window after clicking the Chat button when the Presence feature is enabled. An agent only sees the SMEs who are assigned to the agent’s work flow group. A supervisor, however, sees all of the SMEs in all of the work flow groups that are associated with the supervisor’s teams.

**NOTE:** Agents and supervisors must restart Agent Desktop and Supervisor Desktop to see any changes you make to contact lists.

Unified Presence can be configured to allow you to assign up to 100 SMEs to a contact list in Unified Presence 6.0, and up to 200 SMEs to a contact list in Unified Presence 7.0 or higher.

Use the Contact Lists node to complete the following tasks.

- Creating a Contact List (page 178)
- Finding a Contact List (page 179)
- Deleting a Contact List (page 180)
- Editing a Contact List (page 180)
- Adding SMEs to a Contact List (page 182)

Creating a Contact List

**To create a contact list:**

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists page appears (Figure 83).

Figure 83. Contacts Lists page
2. Create a new contact list by clicking Add New. The Add New page appears (Figure 84).

Figure 84. Add New page

3. Type a name in the Contact List Name field and a description in Contact List Description.

4. Click Save, then click Return to Contact list. The Contact Lists page reappears with the new contact list.

**NOTE:** A contact list name has a maximum of 64 characters.

**Finding a Contact List**

You can search for a contact list from any of the following pages.

- Contact Lists page. Navigate to this page by choosing Cisco Unified Presence Settings > Contact Lists.

- Work Flow Groups page. Navigate to this page by choosing Cisco Unified Presence Settings > Work Flow Groups, then selecting a work flow group.

  **NOTE:** Searches are not case sensitive. For example, if you type a lowercase letter “s” in a search field, the results will include all items that begin with the lowercase letter “s” and the uppercase letter “S.”

  **To find a contact list:**

1. Select a descriptor from the Search for drop-down list, then type one or more characters in the text field.
2. If necessary, complete any of the following actions.

- If you want to add another condition to the search query, click +. A new row containing a field drop-down list, a descriptor drop-down list, and a text field appears. Repeat step 1 for the new row.

- If you want to remove the last condition from the search query, click —. The bottom row is deleted. If you click — and the search query only contains one condition, no change occurs.

- If you want to remove all of the conditions from the search query, click Clear Filter. All of the rows except the first row are deleted, and the first row is reset to the default value.

3. When you are done creating your search query, click Find. A list of contact lists that match all of the conditions appears.

Deleting a Contact List

To delete a contact list:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists page appears (Figure 83).

2. If necessary, search for the contact list you want to delete. For instructions, see "Finding a Contact List" on page 179.

3. Select the check box that corresponds to the contact list you want to delete, then click Delete Selected. The selected contact list is no longer displayed in the list of contacts. However, the actual deletion is not performed until you click Save.

Editing a Contact List

To edit a contact list:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists page appears (Figure 83).

2. If necessary, search for the contact list you want to edit. For instructions, see "Finding a Contact List" on page 179.
3. Select the contact list by clicking its name. The page for that specific contact list appears (Figure 85).

Figure 85. Contacts List page — specific list

4. Complete one or both of the following operations.
   - If you want to remove one or more SMEs from the contact list, clear the corresponding check boxes in the Included column.
   - If you want to change the description of the contact list, type the new description in the Contact List Description field.

5. When you are finished making changes, click Save, then click Return to Contact list.
Adding SMEs to a Contact List

Desktop Administrator searches the Unified Presence LDAP server for SMEs, and when found, saves them to the CAD LDAP server.

**NOTE:** If you want to provide access to users in an external environment who are not managed by the Unified Presence LDAP server, you can add them manually as external contacts. For instructions, see "Adding External Contacts" on page 187.

**To add SMEs to a contact list:**

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists page appears (Figure 83).

2. Select a contact list by clicking its name. The page for that specific contact list appears. If the contact list you selected does not include any SMEs, the Subject Matter Expert List will be empty (Figure 86).

Figure 86. Specific contact list page with no SMEs
3. Find the SME you want to add using the Search function. For instructions about finding SMEs, see "Finding SMEs on page 183. Figure 87 shows the SMEs whose last name begins with the letter “s” and also contains the letter “c.”

Figure 87. Specific contact list page with SMEs

4. Select the SMEs you want to add to the contact list.
   - To add all of the SMEs that are displayed, click Select All.
   - To add SMEs individually, select the corresponding check box in the Included column.

5. If you want to find and add other SMEs, repeat steps 3 and 4.

6. When you are done adding SMEs, click Save, then click Return to Contact list

   NOTE: CAD displays contacts based on the e-mail address in Unified Presence Server. For example, username@domain.com. The full name under personal contacts is displayed only if they are configured within a contact list.

Finding SMEs

   NOTE: Searches are not case sensitive. For example, if you type a lowercase letter “s” in a search field, the results will include all items that begin with the lowercase letter “s” and the uppercase letter “S.”

   NOTE: You can only search for SMEs from the page of a specific contact list.
To find SMEs:


2. Select a contact list by clicking its name. The page for that specific contact list appears.

3. If you do not want the search results to include SMEs who are already in the current contact list, select Included from the Search for field drop-down list and False from the criterion drop-down list, then click +. A new condition with default values (Included and True) is added to the search query (Figure 88).

NOTE: If you use the Included field in a search condition, you must add a second condition that uses the Last Name or First Name field. You cannot search using the Included field alone.

Figure 88. Search query with two conditions (default)
4. Select either Last Name or First Name from the field drop-down list and a descriptor from the drop-down list, then type one or more characters in the search field (Figure 89).

Figure 89. Search query with two conditions

NOTE: You can also leave the Last Name and First Name fields blank in order to find all SMEs, or all SMEs who fit your other search criteria. If the search returns more than 500 results, only the first 500 will be displayed.

5. If necessary, complete any of the following actions.
   - If you want to add another condition to the search query, click +. A new row containing a field drop-down list, a descriptor drop-down list, and a text field appears. Repeat step 4 for the new row.
   - If you want to remove the last condition from the search query, click —. The bottom row is deleted. If you click — and the search query only contains one condition, no change occurs.
   - If you want to remove all of the conditions from the search query, click Clear Filter. All of the rows except the first row are deleted, and the first row is reset to the default value.
6. When you are done creating your search query, click Find. A list of SMEs that match all of the conditions appears (Figure 90).

Figure 90. Search query with results
Configuring External Contacts

If you have an external environment with subject matter experts who do not use Cisco Unified Personal Communicator but who do use Microsoft Office Communicator (MOC), you can use the External Contacts feature to provide access to those additional users.

Use the External Contacts node to complete the following tasks.

- Adding External Contacts (page 187)
- Finding an External Contact (page 189)
- Editing an External Contact (page 190)
- Deleting an External Contact (page 190)

Adding External Contacts

To add an external contact:

1. Choose Cisco Unified Presence Settings > External Contacts. The External Contacts page appears (Figure 91).

Figure 91. External Contacts page
2. Click Add New. The Add New page appears (Figure 92).

![Add New page](image)

3. Complete the fields as described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>Optional. Maximum of 128 characters. No restrictions on the characters that can be entered.</td>
</tr>
<tr>
<td>First Name</td>
<td>Optional. Maximum of 128 characters. No restrictions on the characters that can be entered.</td>
</tr>
<tr>
<td>URI</td>
<td>Uniform Resource Indicator. Required. No restrictions on the length or characters that can be entered.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Optional. No restrictions on the length or characters that can be entered.</td>
</tr>
</tbody>
</table>

4. Click Save to save your changes. The external contact is added.

**NOTE:** After you click Save, you cannot edit the URI field. If you want to change the URI of an existing external contact, you must delete the external contact and create a new external contact with the new URI.

5. If you want to create additional external contacts who have similar information, click Copy, edit the fields as needed, then click Save.

6. When you are finished adding an external contact, click Return to External contact list.
Finding an External Contact

NOTE: Searches are not case sensitive. For example, if you type a lowercase letter “s” in a search field, the results will include all items that begin with the lowercase letter “s” and the uppercase letter “S.”

To find an external contact user:

1. Choose Cisco Unified Presence Settings > External Contacts. The External Contacts page appears (Figure 91).
2. Select a field (for instance, Last Name) and a descriptor (for instance, Begins With), then type one or more characters in the text field.
3. If necessary, complete any of the following actions.
   - If you want to add another condition to the search query, click +. A new row containing a field drop-down list, a descriptor drop-down list, and a text field appears. Repeat step 2 for the new condition.
   - If you want to remove the last condition from the search query, click −. The bottom row is deleted. If you click − and the search query only contains one condition, no change occurs.
   - If you want to remove all of the conditions from the search query, click Clear Filter. All of the rows except the first row are deleted, and the first row is reset to the default value.
4. When you are done creating your search query, click Find. A list of external contacts that match all of the conditions appears (Figure 93).
Editing an External Contact

To edit an external contact:

1. Choose Cisco Unified Presence Settings > External Contacts. The External Contacts page appears (Figure 91).

2. If you do not see the external contact you want to edit, use the search function to find the contact. For instructions, see “Finding an External Contact” on page 189.

3. Select an external contact by clicking the user’s last name. The page for the specific external contact (Figure 94).

4. Change the user’s last name, first name, or phone number by typing new information in the corresponding field.

5. When you are finished making changes, click Save, then click Return to External Contacts list.

Deleting an External Contact

To delete an external contact:

1. Choose Cisco Unified Presence Settings > External Contacts. The External Contacts page appears (Figure 91).

2. If necessary, search for the external contacts that you want to delete. For instructions, see “Finding an External Contact” on page 189.
3. Select the check box corresponding to one or more external contacts, then click Delete Selected. The selected external contacts are no longer displayed in the list of external contacts. However, the actual deletion is not performed until you click Save.
Configuring Work Flow Groups

Use the Work Flow Groups node to add the contact lists that you create to work flow groups. You can assign up to 25 contact lists to a work flow group. For the limits on the number of SMEs in a contact list, see "Configuring Contact Lists" on page 178.

NOTE: You cannot create work flow groups or assign work flow groups to agents in Desktop Administrator. You must create and assign work flow groups in Desktop Work Flow Administrator.

Use the Work Flow Groups node to complete the following tasks.

- Finding a Work Flow Group (page 192)
- Adding a Contact List to a Work Flow Group (page 193)
- Selecting Agents to Appear Offline (page 195)

Finding a Work Flow Group

NOTE: Searches are not case sensitive. For example, if you type a lowercase letter “s” in a search field, the results will include all items that begin with the lowercase letter “s” and the uppercase letter “S.”

To find a work flow group:

1. Choose Cisco Unified Presence Settings > Work Flow Groups. The Work Flow Groups page appears (Figure 95).

Figure 95. Work Flow Groups page
2. Create a search query using one or more conditions as described below.

- If you want to search for work flow groups by name, select Work Flow Group from the field drop-down list and any item from the criterion drop-down list, then type one or more characters in the text field.

- If you want to search for work flow groups for which agents appear offline, select Agents appear offline from the field drop-down list and True from the criterion drop-down list.

- If you want to add another condition to the search query, click +. A new row containing the field drop-down list, the descriptor drop-down list, and the text field appears. Define the new condition as described above.

- If you want to remove the last condition from the search query, click –. The bottom row is deleted. If you click – and the search query only contains one condition, no change will occur.

- If you want to remove all of the conditions from the search query, click Clear Filter. All of the rows except the first row are deleted, and the first row is reset to the default value.

3. When you are finished creating your search query, click Find. A list of work flow groups that match all of the conditions appears.

Adding a Contact List to a Work Flow Group

To add a contact list to a work flow group:

1. Choose Cisco Unified Presence Settings > Work Flow Groups. The Work Flow Groups page appears (Figure 95).

2. If necessary, search for the work flow group to which you want to add a contact list. For instructions, see "Finding a Work Flow Group" on page 192.
3. Select a work flow group by clicking the name of the group. The page for the selected work flow group appears (Figure 96).

![Specific work flow group page](image)

**Figure 96.** Specific work flow group page

4. If necessary, search for the contact lists you want to add to the selected work flow group. For instructions, see "Finding a Contact List" on page 179.

5. Add up to 25 contact lists by selecting the corresponding check boxes in the Included column (Figure 97). To select all of the contact lists, click Select All.

![Specific work flow group page — several contact lists selected](image)

**Figure 97.** Specific work flow group page — several contact lists selected

6. Repeat step 4 and step 5 if you want to find and add additional contact lists to the selected work flow group.

7. When you are finished adding contact lists, click Save, then click Return to Work Flow Group list.
Selecting Agents to Appear Offline

You can configure agents within a work flow group to appear as offline to SMEs in the Contact Selection window.

*To select agents within a work flow group to appear offline:*

1. Choose Cisco Unified Presence Settings > Work Flow Groups. The Work Flow Groups page appears (Figure 95).
2. Select the Agents appear offline check box that corresponds to the work flow group that contains the agents you want to appear as offline in the Chat Selection window.
3. Click Save when finished.
Configuring Supervisor Chat and Team Messages

Use the Supervisor Chat and Team Messages node to configure whether or not supervisors can send chat messages and/or team messages to agents on their team. This setting is global, and cannot be limited to specific teams or workflow groups.

Changes take effect the next time the supervisor starts Supervisor Desktop.

To enable or disable supervisor chat and/or team messages:

1. Choose Cisco Unified Presence Settings > Supervisor Chat and Team Messages. The Supervisor Chat and Team Messages page appears (Figure 98).

2. By default, both supervisor chat and team messages are enabled. To disable one or both, select the associated check box.

3. Click Save.
Introduction

Agent E-Mail can be configured only if you have the Premium package. The Agent E-Mail Settings node is not displayed if you have the Standard or Enhanced package.

Prerequisites

Before the Agent E-Mail feature can function, there are settings that must be configured in Microsoft Exchange and Cisco Unified CCX Application Administration.

- Microsoft Exchange: Set up the Agent E-Mail user account, distribution lists, and mailboxes
- Unified CCX Application Administration: Set up CSQs and skills

See “Configuring Agent E-Mail” in the Cisco CAD Installation Guide for information on setting up these prerequisites, and for information on how the Agent E-Mail feature manages customer e-mails and agent replies to those e-mails.

Overview

Configuring Agent E-Mail in Desktop Administrator consists of the following tasks.

- Configuring Global Settings (page 199)
- Configuring Contact Service Queue Settings (page 205)
- Configuring Templates (page 210)

Customers can send e-mail to e-mail addresses assigned to specific customer service queues. The CSQs funnel the customer e-mails to agents who service those CSQs.

Agents put themselves in the E-Mail Ready state to receive customer e-mail. Going into the E-Mail Ready state signals Agent Desktop to deliver the configured number of customer e-mails to the agent’s desktop. Depending on how it is configured, an agent
can work on up to 5 customer e-mails at a time. The agent can also take the following actions:

- Requeue the e-mail if the agent wants it to be handled by another agent in the same CSQ.
- Transfer the e-mail to a different, more appropriate CSQ.
- Save the e-mail as a draft so it can be worked on at a later time.
- Delete the e-mail. If an e-mail address is specified in the Forwarding Address for Deleted E-Mails field, then the deleted e-mail gets forwarded to the specified e-mail address where supervisors can evaluate it for true deletion or for requeuing if it needs to be handled.
- Send their response to the customer. Their response can include boilerplate text inserted from templates and attached files of any format.

If the agent’s work flow group and E-Mail CSQ are configured for review, then all the agent's responses are transferred to the E-Mail Review CSQ. The E-Mail Review CSQ is used to review your responses to the customer e-mails.

**NOTE:** E-mail cannot be transferred manually to the E-Mail Review CSQ.

Agents who are assigned to the E-Mail Review CSQ review each e-mail before it is sent to the customer. Reviewers can do the following actions on the reply e-mail:

- Edit the agent’s response and any attachments.
- Requeue the e-mail back into the E-Mail Review CSQ to be reviewed by another reviewer.
- Transfer the e-mail to its original CSQ to be handled by the next available agent. In this case, any edits the reviewer made to the e-mail are preserved and the e-mail is saved as a draft.

The system can be configured to send an automated response to every customer e-mail, retention periods for keeping e-mail in the e-mail store, and other settings.
Configuring Global Settings

You can configure the following settings on the Global Settings page of the Agent E-Mail Settings node:

- IMAP server information
- SMTP server information
- Other global settings
To configure global e-mail settings:

1. Choose Agent E-Mail Settings > Global Settings. The Global Settings page appears (Figure 99).

Figure 99. Global Settings page

2. Complete the fields as described below.
If you change any of the IMAP or SMTP server settings listed below, Desktop Administrator attempts to validate the connection and authenticate into the respective IMAP and/or SMTP connector. If this validation passes, the settings are saved. If the validation does not pass, an error message displays and the settings are not saved.

**NOTE:** Desktop Administrator validates the connection and authenticates into the SMTP connector specified. However, a test e-mail is not sent as part of the validation. The validation does not guarantee agents will be able to send e-mails with this connector. Additional configuration might be required to give the agents the necessary permissions to send e-mail messages. See the *Cisco CAD Installation Guide* and the *Cisco CAD Troubleshooting Guide* for more information.

**NOTE:** If you make any changes to the IMAP or SMTP server host/IP addresses, you must log out, exit, and restart the CAD desktop application for changes to take effect.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMAP Server</td>
<td></td>
</tr>
<tr>
<td>Host/IP Address</td>
<td>The hostname or IP address of the Internet Message Access Protocol (IMAP) server.</td>
</tr>
<tr>
<td>Port</td>
<td>The port used to access the IMAP server.</td>
</tr>
<tr>
<td>User Name</td>
<td>Username required to gain access to the IMAP server. If the e-mail account associated with the inbox on the MS Exchange IMAP server is also associated with an NT domain account, the IMAP server login field must be specified as that domain account’s alias. For example, if your Exchange user login name (e-mail address) is <a href="mailto:Jane.Doe@mydomain.com">Jane.Doe@mydomain.com</a>, and the account’s alias is jdoe, then the IMAP login is jdoe. If you are using Integrated Windows Authentication, then the username must be in Windows domain login format. Using the previous example, the username entered must be mydomain\jdoe. <strong>NOTE:</strong> This e-mail account must be valid and able to receive e-mail for Agent E-Mail to work.</td>
</tr>
</tbody>
</table>
Password required to gain access to the IMAP server. Supported authentication mechanisms are plain text authentication logon (either through Basic Authentication or Integrated Windows Authentication), and secure logon (using Transport Layer Security (TLS)).

**SMTP Server**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host/IP Address</td>
<td>The hostname or IP address of the Simple Mail Transfer Protocol (SMTP) server.</td>
</tr>
<tr>
<td>Port</td>
<td>The port used to access the SMTP server.</td>
</tr>
<tr>
<td>User Name</td>
<td>Username required to gain access to the SMTP server. Enter a valid e-mail reply address. This is usually the default reply address for the account configured on the IMAP server. For example, if the IMAP username is <a href="mailto:jane.doe@mydomain.com">jane.doe@mydomain.com</a>, then that is also the SMTP username. A different reply e-mail address can be configured as long as it is a working e-mail address that can be used to send mail by the MS Exchange server.</td>
</tr>
</tbody>
</table>

**NOTE:** This e-mail account must be valid and able to send e-mail for the Agent E-Mail feature to work.

**NOTE:** If you are using Open Relay, the SMTP username and password fields must be left blank. No authentication is completed when connecting to an Open Relay connector.

Password required to gain access to the SMTP server. Supported authentication mechanisms are Open Relay, Basic Authentication, and Integrated Windows Authentication over non-encrypted or TLS (Transport Layer Security) connections.

**NOTE:** If you are using Open Relay, the SMTP username and password fields must be left blank. No authentication is completed when connecting to an Open Relay connector.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Number of E-Mails on Agent Desktop</td>
<td>The maximum number of e-mails an agent can have on the desktop at any one time. Minimum is 1, maximum is 5. The e-mails can be in draft or in process.</td>
</tr>
<tr>
<td>Retention Period for E-Mails Sent and Handled (Days)</td>
<td>The number of days that sent and handled e-mails are retained in the mail store. After the time period is up, the sent and handled e-mails are permanently deleted from the mail store.</td>
</tr>
<tr>
<td>Retention Period for E-Mails Pending Delete and System Status (Days)</td>
<td>The number of days that pending delete and system status e-mails are retained in the mail store. After the time period is up, the e-mails are permanently deleted from the mail store.</td>
</tr>
<tr>
<td>Retention Period for E-Mails Pending Review (Days)</td>
<td>The number of days that e-mails pending for review are retained in Review CSQ. After the time period is up, the e-mails are automatically sent to the customers if configured by the administrator in Contact Service Queue Settings.</td>
</tr>
<tr>
<td>Enable E-Mail Print Button</td>
<td>Select this check box to allow agents to print the e-mail contents along with any agent-composed draft text.</td>
</tr>
<tr>
<td>Enable Re-queue of E-Mails on Agent Logout</td>
<td>Select this check box to requeue all e-mails assigned to an agent to the same CSQ when the agent logs out or closes Agent Desktop so that other agents in the Ready state can work on them. Any drafts in progress at the time of the logout are saved automatically.</td>
</tr>
</tbody>
</table>

**NOTE:** In the event of a failover, even though the agent is automatically logged out of Agent Desktop, the agent's e-mails are not requeued if this option is enabled. The agent will be able to continue working on the e-mails after failover.
3. Click Save to save your changes.

**NOTE:** By default, Agent E-Mail alerts are turned off. These alerts notify you through logs that the page is not configured properly, or it cannot connect to the IMAP/SMTP server, or there is an invalid IMAP/SMTP server setting. The alerts can be enabled through the CLI command “set uccx cad log servicename log <key> <value>,” where key = Alarm and value = Enable or Disable. See “Executing CLI Commands” in the Cisco CAD Troubleshooting Guide for more information.
Configuring Contact Service Queue Settings

There are two types of Agent E-Mail CSQs:

- **CSQ.** Customers send e-mails to e-mail addresses assigned to specific customer service queues. The CSQs funnel the customer e-mails to agents who service those CSQs. Agents receive customer e-mail when in E-Mail Ready state and reply to the e-mails. The e-mail responses are delivered to the customers without any internal review.

- **Review CSQ.** Agent e-mail responses can be configured to be delivered to an internal Review CSQ prior to its delivery to the customers to ensure content quality. Reviewers who service Review CSQ are appropriately skilled supervisors or agents. Reviewers can edit, transfer, re-queue, and send reviewed e-mail using the Agent E-Mail functionality. When the reviewer sends the e-mail to the customer, the e-mail shows the e-mail address of the original CSQ to which it was queued, not the e-mail of the E-Mail Review CSQ.

Use the Contact Service Queue Settings page to configure how e-mail that is sent to specific CSQs is handled.

Finding a CSQ

*To find a specific CSQ:*

1. Choose Agent E-Mail Settings > Contact Service Queue Settings. The Contact Service Queue List page appears (Figure 100). This page contains a list of all the E-Mail CSQs configure in Unified CCX.

![Figure 100. Contact Service Queue List page](image)

2. If necessary, search for the CSQ you want to edit. For instructions, see "Using the Search Function" on page 148.
Configuring a CSQ

1. When you have found the CSQ you want to configure, click its name. The settings page for the selected CSQ appears.

Figure 101. Contact Service Queue Settings page

2. Complete the fields as described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td></td>
</tr>
<tr>
<td>Enable Outbound Attachments</td>
<td>Select this check box to allow agents to send attachments.</td>
</tr>
</tbody>
</table>
### Configuring Contact Service Queue Settings

Enable E-Mail Forwarding

Select this check box to allow agents to forward a message to an external account.

**NOTE:** Forwarding an e-mail by an agent does not mean that the e-mail is resolved. However, it allows the agent to compose a note or a comment to the forwarded recipient(s). The e-mail will still be assigned to the agent for resolution.

Forward using E-Mail Address

Type the e-mail address to be used for sending the forwarded message.

This field is enabled only if you select Enable E-Mail Forwarding check box.

Forward Template

Select a template from the drop-down menu that will automatically be included with the message when agents forward the message.

This field is enabled only if you select Enable E-Mail Forwarding check box.

Enable CC Field

Select this check box to allow agents to copy in an external e-mail on their response.

Enable BCC Field

Select this check box to allow agents to copy in a blind external e-mail on their response.

Any address entered in the CC field is visible to all e-mail recipients, while addresses entered in the BCC field are not visible to any e-mail recipients.

**NOTE:** This is in addition to any automatic BCCs configured for the CSQ in the BCC All Responses to E-Mail Address field.

Send Responses Using E-Mail Address

Type the e-mail address from which agent responses are to be sent.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable E-Mail Forwarding</td>
<td>Select this check box to allow agents to forward a message to an external account. <strong>NOTE:</strong> Forwarding an e-mail by an agent does not mean that the e-mail is resolved. However, it allows the agent to compose a note or a comment to the forwarded recipient(s). The e-mail will still be assigned to the agent for resolution.</td>
</tr>
<tr>
<td>Forward using E-Mail Address</td>
<td>Type the e-mail address to be used for sending the forwarded message. This field is enabled only if you select Enable E-Mail Forwarding check box.</td>
</tr>
<tr>
<td>Forward Template</td>
<td>Select a template from the drop-down menu that will automatically be included with the message when agents forward the message. This field is enabled only if you select Enable E-Mail Forwarding check box.</td>
</tr>
<tr>
<td>Enable CC Field</td>
<td>Select this check box to allow agents to copy in an external e-mail on their response.</td>
</tr>
<tr>
<td>Enable BCC Field</td>
<td>Select this check box to allow agents to copy in a blind external e-mail on their response. Any address entered in the CC field is visible to all e-mail recipients, while addresses entered in the BCC field are not visible to any e-mail recipients. <strong>NOTE:</strong> This is in addition to any automatic BCCs configured for the CSQ in the BCC All Responses to E-Mail Address field.</td>
</tr>
<tr>
<td>Send Responses Using E-Mail Address</td>
<td>Type the e-mail address from which agent responses are to be sent.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BCC All Responses to E-Mail Address</td>
<td>Type the blind carbon copy (BCC) e-mail address to which all agent responses to the customer e-mail are to be sent.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> If your configuration uses Microsoft Exchange Server 2007, CAD does not route e-mail based on an address in the BCC field. The CSQ e-mail address must be in the TO field for the e-mail to be routed correctly.</td>
<td></td>
</tr>
</tbody>
</table>

**Review Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send E-Mails for Review to:</td>
<td>Select this check box and the CSQ to which to send e-mails for review.</td>
</tr>
<tr>
<td>This is a Review CSQ</td>
<td>Select this check box to make it a Review CSQ. When this option is enabled, e-mails sent by agents from a regular CSQ are transferred to the Review CSQ. Agents assigned to the Review CSQ review the agent response and edit or requeue the message, or send it on to the customer. If you select this option, the Send E-Mails for Review to option is disabled. An e-mail from the Review CSQ cannot be sent to any other CSQ. In addition, if a CSQ is assigned as a Review CSQ, you cannot configure the Automatic Response options.</td>
</tr>
<tr>
<td>Automatically Send idle E-Mails</td>
<td>Select this check box to send messages that have been in the Review queue for an extended period of time on to the customer. The time period is configured on the Global Settings page. This field is enabled only if the CSQ is a Review CSQ. Selecting this option helps prevent long delays in delivering the reply to the customer in instances where an agent’s response is not reviewed in a timely manner.</td>
</tr>
</tbody>
</table>

**Automatic Response**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send automatic response</td>
<td>Select this check box if you want to send an automated response to all who send an e-mail to this CSQ.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> When sending a single e-mail to multiple addresses that are mapped to multiple e-mail CSQs, only one of the CSQs will get the e-mail, and therefore only a single auto-response will be sent if configured for that CSQ.</td>
<td></td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Template</td>
<td>Select the template that you want to set for automatic response. This field is enabled only if you select Send automatic response.</td>
</tr>
</tbody>
</table>
| Send responses using E-Mail address | Type the e-mail address from which automated responses are to be sent.  
Sending the automated responses from a different e-mail address prevents automatic response loops because the automated response e-mail address cannot receive e-mail messages. Any responses sent to that e-mail address will not be attended.  
**NOTE:** If this field is left blank, CAD will use the response e-mail address configured in the Settings section. If that field is blank, CAD will use the e-mail address in the E-Mail addresses that map to this CSQ section. |
| E-Mail addresses that map to this CSQ | The one or more e-mail addresses that map to the CSQ. E-mail addresses are case sensitive. Any e-mail sent to these addresses is routed to agents assigned to the CSQ. These e-mail addresses are the addresses of distribution groups set up in Active Directory, each of which contains only one member, the e-mail address set up as the Agent E-Mail user in Active Directory. See the Cisco CAD Installation Guide for information on setting up the user and distribution groups. |

3. Click Save to save your changes.
Configuring Templates

Templates are created for setting auto-response for replying to incoming e-mails, as well as agents can manually insert into their responses to customer e-mails. They enable agents to answer common e-mail questions and problems with consistent and accurate answers. You can add up to 500 templates.

Use the Templates page on the Agent E-Mail Settings node to complete the following tasks.

- Adding a Template (page 210)
- Copying a Template (page 212)
- Deleting a Template (page 213)

Adding a Template

To add a template:

1. Choose Agent E-Mail Settings > Templates. The Template List page appears (Figure 102).

   Figure 102. Template List page
2. Click Add New. The Add New page appears (Figure 103).

Figure 103. Add New page

3. Complete the fields as described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Name</td>
<td>The name that identifies the template. Maximum length = 64 characters.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of the template you want to create. You can create an Auto-Response or Agent templates:</td>
</tr>
<tr>
<td></td>
<td>• Auto-Response templates are used for automatically replying to e-mails and forwarded e-mails.</td>
</tr>
<tr>
<td></td>
<td>• Agent templates are used by agents when replying to e-mails.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the template. Maximum length = 64 characters.</td>
</tr>
</tbody>
</table>
Copying a Template

You can copy the information of an existing template and then customize that information for a new template. You might want to do this if the name, description, type and/or text of a new template is very similar to the name, description, type and/or text of an existing template.

To copy a template:

1. Choose Agent E-Mail Settings > Templates. The Template List page appears (Figure 102).
2. If necessary, search for the template you want to copy. For instructions, see "Using the Search Function" on page 148.
3. Click the template you want to copy. The Template Information page appears.
4. Click Copy. The Template Information page now shows the template name as “Copy of <original template name>” and the description as “Copy of <original template description>”. The original template’s text is also displayed.
5. Customize the template information fields to be appropriate for the new template, and then click Save. The new template is now listed in the Template List page.

4. Click Save to save your changes. The template is added to the Template List.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Type the text that you want to save in the template. Maximum length = 1000 characters. You can also insert variables into the Text field to customize the template contents. The variables are automatically replaced by the appropriate text when the message is sent. In case of agent templates, the variables are automatically replaced when the template is inserted into the message. The following variables are supported in this field:</td>
</tr>
<tr>
<td></td>
<td>■ ${agentId}</td>
</tr>
<tr>
<td></td>
<td>The agent’s ID</td>
</tr>
<tr>
<td></td>
<td>■ ${agentName}</td>
</tr>
<tr>
<td></td>
<td>The agent’s full name</td>
</tr>
<tr>
<td></td>
<td>■ ${agentExtension}</td>
</tr>
<tr>
<td></td>
<td>The agent’s extension</td>
</tr>
<tr>
<td></td>
<td>Variables are case sensitive. Unsupported variables in a template will not be replaced with text.</td>
</tr>
</tbody>
</table>
Deleting a Template

To delete a template:

1. Choose Agent E-Mail Settings > Templates. The Template List page appears. (Figure 102)

2. If necessary, search for the template you want to delete. For instructions, see "Using the Search Function" on page 148.

3. Select the check box corresponding to one or more templates, then click Delete Selected. The selected templates are no longer displayed in the Template list. However, the actual deletion is not performed until you click Save.
Introduction

The CAD Configuration Setup page is used to modify configuration settings that were initially set up during installation. One reason this might become necessary is if a CAD server IP address is changed. Use this page to do the following:

- Enable/disable automatic updates
- Change the IP address of the CAD-BE servers
- Change the IP address of the CAD services
- Change the login credentials for the BIPPA service
- Clear the password set for Desktop Work Flow Administrator

Other CAD configuration settings are changed using the CAD Configuration Setup utility. This utility can be accessed either from the Desktop Work Flow Administrator menu bar or by launching PostInstall.exe. See the Cisco CAD Installation Guide and "Modifying the Unified CCX Server IP Address" on page 17 for more information on using the CAD Configuration Setup utility.
Configuring CAD Configuration Setup Settings

To configure CAD Configuration Setup settings:

1. Choose the CAD Configuration Setup node from the navigation tree. The CAD Configuration Setup page appears (Figure 104).

Figure 104. CAD Configuration Setup
2. Complete the fields as described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Updates</td>
<td>Select this check box to allow the CAD desktop applications to update automatically. By default, automatic update is enabled for all the CAD applications. Automatic software update requires either administrative or elevated (system) privileges.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>The CAD client applications must be of the same version as the CAD server to function properly. If this setting is disabled, the administrator must distribute and install the software updates on all the CAD client applications.</td>
</tr>
<tr>
<td>CAD-BE Servers</td>
<td></td>
</tr>
<tr>
<td>Primary Location</td>
<td>The host name or IP address of the primary CAD Base Services server. Apache Tomcat, which is required to run CAD-BE, is installed on this server.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>If some of your agents are outside the firewall, use the external hostname/IP address that maps to the server. If all your agents are inside the firewall, use the internal hostname/IP address.</td>
</tr>
<tr>
<td>Secondary Location</td>
<td>The host name or IP address of the secondary CAD Base Services server. The secondary server hosts the CAD Base Services and you must have configured replication between the primary and secondary server.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>If you establish replication in initial mode, the Secondary Location field is filled automatically.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>The Secondary Location field is not enabled until you configure the secondary CAD Base Services server and establish replication.</td>
</tr>
<tr>
<td>Services IP Address</td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>Select the Unified CCX Server IP address of the NIC used to connect to the LAN—it must be accessible by the client desktops.</td>
</tr>
</tbody>
</table>
3. Click Save to save the changes.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIPPA User Login</td>
<td>Login ID to gain access to the BIPPA service for connecting to the Unified CM. This login ID and password are also set up in Unified CM. You can complete these fields before setting up the user in Unified CM, but the login ID and password must be identical in both places. If they are changed in this window or in Unified CM, they must be changed in both.</td>
</tr>
<tr>
<td>Login ID</td>
<td>Login ID to gain access to the BIPPA service for connecting to the Unified CM. This login ID and password are also set up in Unified CM. You can complete these fields before setting up the user in Unified CM, but the login ID and password must be identical in both places. If they are changed in this window or in Unified CM, they must be changed in both.</td>
</tr>
<tr>
<td>Password</td>
<td>Password required to gain access to the BIPPA service.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Re-enter the password.</td>
</tr>
<tr>
<td>Reset Password</td>
<td>Click Reset Password to clear the password set for accessing Desktop Work Flow Administrator.</td>
</tr>
</tbody>
</table>

**NOTE:** If Directory Services is not running when you view this section, the BIPPA login information cannot be changed.
Index

A

Actions 96
  adding a new action 98
  availability 97
  deleting 99
  editing 99
  importing and exporting 99
  types
    agent notification 103
    agent state 105
    call control 107
    delay 108
    HTTP 109
    IPC 117
    launch external application 119
    Outbound Dialer 141
    run macro 121
    set enterprise data 132
    timer 134
    utility 135
Agent E-Mail
  global settings 199
  introduction 197
Agent management work flows
  general procedure 92
  overview 91
  setting up CAD activity and agent state work flows 93
  setting up time of day work flows 93
Agents
  changing work flow group assignment 170
  configuring 170
Assigning phones to a VoIP monitor service 163
Automated updates
  Desktop Administrator
    automated updates 19
  Downgrade 20
Automatic state changes
  enabling/disabling 57

B

BIPPA User Login
  setting 218
Browser Setup 72

C

CAD Configuration Setup
  modifying
    Unified CCX Server IP address 17
  settings
    BIPPA User Login 218
    CAD-BE Servers 217
    Services IP Address 217
CAD-BE Servers
  configuring 217
Cisco Unified CCX Outbound Preview Dialer. See Outbound Dialer
Cisco Unified Presence server
  configuring 174
Contact lists
  adding SMEs 182
  configuring 178
  creating 178
  deleting 180
  editing 180
  finding 179
  finding SMEs 183
Contact Service Queues 205
  configuring 206
  finding 205

D

Data fields
  configuring 69
  renaming 70
Desktop Administrator
- accessing the web application 146
- feature levels 12
- forcibly unlocking 167
- introduction 11
- logging in 146
- related documentation 14
- what’s new 12

Desktop and Server Monitoring and Recording 161
- enabling 161

Desktop monitoring
- enabling 161

Desktop Work Flow Administrator
- interface 21
- starting 16
- toolbar 21

Display Settings
- configuring 158

E
- E-Mail Contact Work Flows
  - Agent E-Mail Features 90
- E-Mail Review CSQ
  - CSQ configuration 208
  - work flow configuration 90

Enterprise Data
- configuring 150

External contacts
- adding 187
- configuring 187
- deleting 190
- editing 190
- finding 189

F
- Fields 151
  - creating custom field 151
  - deleting 153
  - editing 153

H
- High priority chat messages 135

I
- IPC receive events
  - IPC Agent Notification action 79
  - IPC High Priority Chat action 78
  - IPC Make Call action 78

IPC Record action 79
- IPC Set Variable action 80

L
- Layouts 155
  - copying 156
  - creating a custom layout 155
  - deleting 157
  - editing 157

M
- Macro actions 121
  - allowed keystrokes 124
  - inserting data fields 128, 129
  - recording 125
  - recording tips 122

Monitor service
- assigning phones to 163
- configuring default 162
- removing 163

Multi-line Calls
- enabling Non-ACD calls display 159
- enabling supervisor monitoring and recording 159

O
- Outbound Dialer 141
  - actions 141
  - and voice contact work flows 88
  - dialing modes 141
  - enterprise data 144
  - toolbar 142

P
- Passwords 24
  - client applications 25
  - Desktop Administrator 146
  - Desktop Work Flow Administrator 24

R
- Reason codes 48
- Remote Access 76
- Removing VoIP Monitor/Recording & Playback services 163
S
Searching Desktop Administrator 148
Services IP Address
   configuring 217
Show Data Fields 69
Show duration 70
Starting Desktop Work Flow Administrator 16
Synchronizing Directory Services 26

T
Templates 210
   adding 210
   deleting 213
Toolbar 65
   associating actions with task buttons 66
   changing button hints 67
   customizing buttons 67
Desktop Work Flow Administrator 21
Outbound Dialer 142

U
Unified CCX Server IP address
   modifying 17
Unified Presence cluster
   configuring 176
Unified Presence settings
   introduction 173
Unlocking Desktop Administrator 167
User Interface window 65
   Browser Setup tab 72
   Miscellaneous tab 71
   Remote Access tab 76
   Show Data Fields tab 69
   Toolbar tab 65
User privileges in Windows XP and Vista 23

V
Voice contact work flows 81
   and Outbound Dialer 88
   data field conditions 85
   deleting 88
   modifying 87
   overview 82
   setting up a new work flow 84
   voice contact classification 83
   wild card searches 87

W
Wild card searches 87
Work flow groups 192
   adding a contact 193
   finding 192
   making agents appear offline 195
Wrap-up data 53
   assigning global 56
   assigning work flow 56
   creating descriptions 54
   deleting descriptions 56
   editing descriptions 55
   enabling/disabling 56